# Table of Contents

**Welcome to Nolij Web** ................................................................. 10

What is Nolij Web? ................................................................. 10

What Can Nolij Web Do? ............................................................ 10

Document Imaging ................................................................. 10

Document Management .......................................................... 10

Forms ....................................................................................... 11

Workflow ................................................................................... 11

  - Priority Student Filter ........................................................ 11
  - Financial Aid Folder Review Assistant .................................. 11
  - Human Resources Performance Reviewer ............................ 12
  - Finance Grant Organizer .................................................... 12

Reporting .................................................................................. 12

Collaboration .......................................................................... 12

**Scanning Basics and Concepts** .................................................... 13

  - Determining Documents to Manage .................................. 13
  - Determining Your Hardware Needs .................................... 13
  - Determining Cost, Volume, and Speed Requirements ......... 13
  - Determining Duplex Versus Simplex Scanning Requirements. 14
  - Determining Scanned Image Quality Requirements ............. 14

    - Keeping the Scanner Clean .............................................. 14
    - Using a Good Original .................................................... 14
    - Understanding Color Depth .......................................... 14
    - Understanding Resolution ............................................. 15
    - Understanding Dynamic Range .................................... 16
    - Understanding Output File Formats ............................... 16
    - Understanding Image File Formats ................................ 16
    - Understanding Non-image File Formats ........................ 16

Before You Scan ........................................................................ 17

  - Selecting the Proper Scanning Resolution .......................... 17
  - Selecting Optimal Scanner Settings .................................... 17
Using Available Scanning Tools .................................................................................................................. 17
Retaining Paper .................................................................................................................................................. 17

**Before You Begin** ........................................................................................................................................ 19
Starting and Logging in to Nolij Web .............................................................................................................. 19
Understanding the User Interface ..................................................................................................................... 20

  Accessing the Context Menu for Mobile and Touch Devices ........................................................................ 24
  Customizing the Nolij Web Display .................................................................................................................. 24
  Customizing Dialog Box Displays .................................................................................................................. 24
  Resizing Panes .................................................................................................................................................. 25
  Collapsing and Expanding Panes .................................................................................................................... 25
  Moving Fields in the Nolij Web Workflow Area ............................................................................................. 25
  Changing Themes ............................................................................................................................................ 25
  Configuring Preferences .................................................................................................................................. 25
  Changing Your Role .......................................................................................................................................... 26

Understanding Nolij Web Workflow .................................................................................................................... 27
Understanding Nolij Web User Roles and Privileges ....................................................................................... 27

**Using Nolij Web** .......................................................................................................................................... 29
Using Nolij Web with Nolij Web Workflows ...................................................................................................... 29
Understanding the Nolij Web Workflow Pane ................................................................................................... 31
Working with Nolij Web Inboxes ........................................................................................................................ 33
Performing Nolij Web Queries .......................................................................................................................... 34
  Performing Subindex Queries .......................................................................................................................... 36
  Performing Batch Queries ............................................................................................................................... 38
  Creating New Batch Folders ............................................................................................................................ 38
  Renaming Batch Folders .................................................................................................................................. 39
  Deleting Batch Folders ..................................................................................................................................... 39
  Clearing Queries .............................................................................................................................................. 39

Searching All Documents for Specified Text ................................................................................................. 39
Configuring How Query Results are Displayed ............................................................................................... 40
Clearing Query Results ...................................................................................................................................... 41
Locking Query Results ....................................................................................................................................... 41
Locking Query Folders ....................................................................................................................................... 41
Locking Documents

Adding Favorite Folders

Viewing the Folder History

Setting Custom Statuses for Folders

Uploading Files to Folders

Viewing the Folder Objects Pane

Opening Documents in the Folder Objects Pane

Opening Documents in New Windows

Scanning Documents

  Scanning Documents Into Query Folders or Subfolders

  Rescanning Pages

  Adding Scanned Pages to Documents

  Changing the Default Scanner

Creating Document Versions

  Creating Document Versions in Internet Explorer 7

Indexing Documents

  Setting Global Documents

  Setting Shared Documents

Modifying ImageNow Document Properties in Nolij Web Workflows

Viewing Nolij Web Document Properties

  Viewing and Configuring Nolij Web Custom Document Properties

  Viewing OCR Properties

Viewing Version Properties

Renaming Documents

Deleting Documents

Recovering Deleted Documents

Duplicating Documents

Merging Documents

Moving Documents into Query Folders

Moving Documents into Subfolders

Emailing Documents

Searching for Documents in the Folder Objects Pane
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filtering Documents by Text</td>
<td>63</td>
</tr>
<tr>
<td>Filtering Documents by Index</td>
<td>64</td>
</tr>
<tr>
<td>Filtering Documents by Custom Property</td>
<td>64</td>
</tr>
<tr>
<td>Adding Template Documents</td>
<td>64</td>
</tr>
<tr>
<td>Adding and Emailing Template Documents</td>
<td>65</td>
</tr>
<tr>
<td>Automatically Indexing Documents</td>
<td>66</td>
</tr>
<tr>
<td>Setting Documents to be Auto-Indexed</td>
<td>67</td>
</tr>
<tr>
<td>Approving Auto-indexed Documents</td>
<td>68</td>
</tr>
<tr>
<td>Setting Identifiers</td>
<td>69</td>
</tr>
<tr>
<td>Resolving Indexes</td>
<td>70</td>
</tr>
<tr>
<td>Importing Emails into the Folder Objects Pane</td>
<td>70</td>
</tr>
<tr>
<td>Configuring Email Server Settings</td>
<td>71</td>
</tr>
<tr>
<td>Manually Importing Emails</td>
<td>72</td>
</tr>
<tr>
<td>Adding Email Import Rules</td>
<td>73</td>
</tr>
<tr>
<td>Modifying Email Import Rules</td>
<td>74</td>
</tr>
<tr>
<td>Deleting Email Import Rules</td>
<td>75</td>
</tr>
<tr>
<td>Running Manual Import Rules</td>
<td>75</td>
</tr>
<tr>
<td>Moving Folders in a Nolij Web Workflow</td>
<td>76</td>
</tr>
<tr>
<td>Moving Folders Manually</td>
<td>76</td>
</tr>
<tr>
<td>Moving Folders in an Automatic Workflow</td>
<td>76</td>
</tr>
<tr>
<td>Removing Folders from the Workflow</td>
<td>77</td>
</tr>
<tr>
<td>Viewing the Graphical Workflow for Nolij Web Workflows</td>
<td>77</td>
</tr>
<tr>
<td>Viewing the Workflow Summary</td>
<td>83</td>
</tr>
<tr>
<td>Working with ImageNow Workflows</td>
<td>83</td>
</tr>
<tr>
<td>Filtering Documents and Folders in ImageNow Workflows</td>
<td>84</td>
</tr>
<tr>
<td>Opening Folders in ImageNow Workflows</td>
<td>87</td>
</tr>
<tr>
<td>Copying ImageNow Documents</td>
<td>87</td>
</tr>
<tr>
<td>Working with Standalone ImageNow eForms</td>
<td>88</td>
</tr>
<tr>
<td>Working with ImageNow Supplemental eForms</td>
<td>88</td>
</tr>
<tr>
<td>Opening Documents in New Windows</td>
<td>88</td>
</tr>
<tr>
<td>Opening Documents in Associated Applications</td>
<td>89</td>
</tr>
<tr>
<td>Modifying ImageNow Document Properties</td>
<td>89</td>
</tr>
</tbody>
</table>
Deleting Items from ImageNow Workflows ......................................................... 90
Removing Items from ImageNow Workflows ..................................................... 90
Setting Item Status .............................................................................................. 90
Routing Items in ImageNow Workflows .............................................................. 90
Emailing ImageNow Documents ....................................................................... 91

Working with ImageNow Document Views ....................................................... 92
Filtering Documents in ImageNow Document Views and Folders in Folder Views .................................................. 92
Adding ImageNow Files to ImageNow Workflows ............................................. 94
Deleting ImageNow Files from ImageNow Document Views ................................ 95

Working with ImageNow Folder Views ............................................................. 95
Adding Folders to ImageNow Workflows ......................................................... 95
Opening Folders in Folder Views ....................................................................... 96
Deleting Folders from ImageNow Folder Views ............................................... 96

Working with ImageNow Task Views ............................................................... 96
Filtering Tasks in ImageNow Task Views ......................................................... 96
Opening Tasks .................................................................................................... 98

Working with Documents in the Document Viewer ........................................... 99
Supported File Types ......................................................................................... 101
Printing Documents .......................................................................................... 104
Moving Documents in Drag Mode ................................................................... 104
Rotating Documents ......................................................................................... 105
Zooming in and Out .......................................................................................... 105
Resizing Documents in the Document Viewer .................................................. 105
Resizing the Document Viewer ........................................................................ 106
Extracting Pages from Documents .................................................................. 106
Showing and Hiding Annotations ..................................................................... 106
Using Nolij Web Annotations ......................................................................... 106
  Highlighting Documents .................................................................................. 107
  Redacting Documents ..................................................................................... 108
  Stamping Documents ...................................................................................... 108
Drawing Circles ................................................................................................. 108
Drawing Lines .................................................................................................... 109
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Free Text</td>
<td>109</td>
</tr>
<tr>
<td>Drawing Squares</td>
<td>110</td>
</tr>
<tr>
<td>Adding Sticky Notes</td>
<td>110</td>
</tr>
<tr>
<td>Using ImageNow Annotations</td>
<td>110</td>
</tr>
<tr>
<td>Highlighting Documents</td>
<td>111</td>
</tr>
<tr>
<td>Drawing Ovals</td>
<td>112</td>
</tr>
<tr>
<td>Drawing Lines</td>
<td>112</td>
</tr>
<tr>
<td>Adding Text</td>
<td>113</td>
</tr>
<tr>
<td>Drawing Rectangles</td>
<td>113</td>
</tr>
<tr>
<td>Adding URLs</td>
<td>114</td>
</tr>
<tr>
<td>Adding Checks</td>
<td>114</td>
</tr>
<tr>
<td>Adding Sticky Notes.</td>
<td>115</td>
</tr>
<tr>
<td>Adding Stamps</td>
<td>115</td>
</tr>
<tr>
<td>Modifying Annotation Colors</td>
<td>116</td>
</tr>
<tr>
<td>Resizing Annotations and Redactions</td>
<td>117</td>
</tr>
<tr>
<td>Moving Annotations and Redactions</td>
<td>117</td>
</tr>
<tr>
<td>Deleting Annotations and Redactions</td>
<td>118</td>
</tr>
<tr>
<td>Working with Forms</td>
<td>118</td>
</tr>
<tr>
<td>Detaching and Attaching Forms in the Form Pane</td>
<td>119</td>
</tr>
<tr>
<td>Working with Reports</td>
<td>120</td>
</tr>
<tr>
<td>Report Viewer Toolbar</td>
<td>121</td>
</tr>
<tr>
<td>Viewing Reports</td>
<td>122</td>
</tr>
<tr>
<td>Exporting Reports</td>
<td>122</td>
</tr>
<tr>
<td>Viewing Advanced Reports</td>
<td>123</td>
</tr>
<tr>
<td>Exporting Advanced Reports</td>
<td>123</td>
</tr>
<tr>
<td>Printing Advanced Reports</td>
<td>123</td>
</tr>
<tr>
<td>Working with the Communication Window</td>
<td>123</td>
</tr>
<tr>
<td>Collaborating with Nolij Web Users</td>
<td>123</td>
</tr>
<tr>
<td>Viewing Collaboration History</td>
<td>124</td>
</tr>
<tr>
<td>Viewing Console Messages</td>
<td>124</td>
</tr>
<tr>
<td>Viewing Debug Messages</td>
<td>124</td>
</tr>
<tr>
<td></td>
<td>124</td>
</tr>
</tbody>
</table>
Appendix A: Using URL Launch ................................................................. 125
  Opening ImageNow workflows .......................................................... 125
  Opening ImageNow document and folder views .................................... 126
  Opening ImageNow folders ............................................................... 127
  Opening Nolij Web workflows, folders, and documents .......................... 128

Index ........................................................................................................ 130
Welcome to Nolij Web

Refer to these topics for more information about Nolij Web:


What is Nolij Web?

Nolij Web is a web-based document imaging and management solution for higher education institutions. It provides an automatic, integrated workflow process that enhances the flow of information between departments and individuals, significantly increasing productivity.

Nolij Web provides a variety of other features, such as reporting, instant messaging, and content management. Based fully on Java, Nolij Web works with all leading higher education Student Information System (SIS) software, integrates with all leading Enterprise Resource Planning (ERP) databases, and is supported on most browser and server platforms.

Your administrator can also configure Nolij Web so that you can use the Nolij Web interface to view and work with ImageNow workflows and views. All tasks you perform in ImageNow workflows and views occur in ImageNow; Nolij Web is only the means by which you can access ImageNow workflows and views. Refer to the appropriate ImageNow documentation for more information about working with ImageNow.

What Can Nolij Web Do?

Nolij Web provides these key features:

- Document Imaging
- Document Management
- Forms
- Workflow
- Reporting
- Collaboration

Document Imaging

You can scan, store, enhance, manage, and view hardcopy documents in Nolij Web.

Document Management

You can store, track, and maintain all of your electronic business information, regardless of file type or format.
Forms

Your administrator can create custom forms to retrieve and save data for records of information.

Workflow

The Workflow feature automates how documents, information, and tasks are passed from one individual to another according to predefined rules and procedures. With this feature, you can:

- Automate the paper and folder flow within or across academic departments to streamline decision making for admissions processes.
- Manage electronic content and distribute work according to workflow rules based on internal policy and procedure.
- Give users unlimited conditional inboxes, allowing support staff to route work to holding queues.
- Allow system administrators to track work and to reroute work systematically based on problems caused by bottlenecks, short-staffing, or sick employees.
- Use email for notification of work that must be completed.
- Review and design workflow paths for highly repetitive processes.

Some of the workflow processes that Nolij Web can provide include:

- Priority Student Filter
- Financial Aid Folder Review Assistant
- Human Resources Performance Reviewer
- Finance Grant Organizer

Priority Student Filter

A priority student workflow automatically prioritizes student folders so you can concentrate on preferred applicants. It is driven by internal functional requirements, such as automatic acceptance or applicant weighting, which gives applicants an overall decision score. It can:

- Prioritize folders based on criteria, such minimum GPA or SAT scores, defined as the important indicators of a successful applicant.
- Ensure that preferred applicants' folders are reviewed soonest, enabling staff to focus time effectively and to respond quickly to applicants.

Financial Aid Folder Review Assistant

A financial aid folder review assistant workflow automates the review and approval of a student's financial aid folder. You can:

- Automatically route financial aid folders to the appropriate reviewer.
- Readily access a student's financial aid history.
• Easily append and circulate comments.
• Attach supporting documents, such as tax forms and receipts.

Human Resources Performance Reviewer
A human resources performance reviewer workflow automates the review and approval of employee bonuses and pay raises. It allows you to:
• Automatically link performance reviews to the employee's human resources record.
• Control and monitor the flow of each review throughout the approval process.
• Enable supervisors to record comments and sign off on a review.
• Route approved reviews to human resources or payroll for salary action in a timely manner.

Finance Grant Organizer
A finance grant organizer workflow converts institutional grant-related documentation into an intuitive virtual filing system. These documents can be automatically routed based on the rules surrounding a specific grant. With it, you can:
• Automatically route support documents, such as grant applications, approval signatures, and supporting documentation.
• Secure access to grant documents by user.
• Enable simultaneous access to grant documents for committee review.

For more information about workflow, see Starting and Logging in to Nolij Web on page 19.

Reporting
You can create ad hoc data models that display critical data for review and planning, and you can probe historical information quickly and easily to compare it to current information. In addition, you can export data to spreadsheet programs such as Microsoft Excel and Corel Quattro Pro.

You can use these data models to identify important trends and to forecast outcomes. You can also combine administrative data reports with process enhancement data to better understand process efficiencies or deficiencies.

Collaboration
You can communicate directly with other Nolij Web users using the Collaboration tool.
Scanning Basics and Concepts

Refer to the following topics for information on planning for your hardware needs, as well as basic scanning concepts and best practices:

- Determining Documents to Manage on page 13.
- Determining Your Hardware Needs on page 13.
- Before You Scan on page 16.
- Retaining Paper on page 17.

Determining Documents to Manage

When deciding which documents you want to convert to an electronic format, you should choose to manage the documents that you are processing in large volumes and those that you need to access and retrieve most frequently.

Determining Your Hardware Needs

Consider some of these issues when determining what hardware you need:

- The volume of documents you will be scanning.
- The speed at which you need the scanner to operate.
- Your budget.
- The importance of the quality of scanned documents.

Refer to the following topics for more information:

- Determining Cost, Volume, and Speed Requirements on page 13.
- Determining Duplex Versus Simplex Scanning Requirements on page 14.
- Determining Scanned Image Quality Requirements on page 14.

Determining Cost, Volume, and Speed Requirements

Nolij Web works with most types of scanning hardware, including those that scan at 5 pages per minute (ppm); 20 ppm; 40 ppm, single-sided documents; and 60 ppm, double-sided documents.

The number and type of scanners you need depend on the volume of images you will be scanning. For planning purposes, a typical medium volume scanner costs between $3,500 and $7,500 and can process approximately 40 or more ppm. Plan to use your scanners at about 40% of their rated capacity to cover the overhead of paper ordering, insertion, extraction, filing, and jam removal.

For example, using a typical 40 ppm scanner at 40% utilization, you can scan at 16 ppm. This means that approximately 7,500 pages that can be scanned per an 8-hour day, allowing you to scan over 30,000 pages per week.
Various setup scenarios may be appropriate depending on your needs, such as using multiple lower-cost and lower-volume scanners in different locations. Nolij consultants can assist you with determining the number, placement, and types of scanners for your requirements.

Determining Duplex Versus Simplex Scanning Requirements

A significant factor in determining your hardware needs is whether you require simplex or duplex scanners. Simplex scanners scan a single side of a document only; duplex scanners scan both sides of a document.

Determining Scanned Image Quality Requirements

The following topics help you understand the issues that impact the quality of scanned documents:

- Keeping the Scanner Clean on page 14.
- Using a Good Original on page 14.
- Understanding Color Depth on page 14.
- Understanding Resolution on page 15.
- Understanding Dynamic Range on page 16.
- Understanding Output File Formats on page 16.
- Understanding Image File Formats on page 16.
- Understanding Non-image File Formats on page 16.

Keeping the Scanner Clean

Make sure your scanner glass is clean before you scan images. You may periodically need to clean your scanner of dust, dirt, and other contaminants to maintain a high quality image.

Refer to your scanner manufacturer's instructions for information on cleaning your scanner.

Notes  Always remove paper clips and staples from documents before scanning.

Using a Good Original

A good original is the most important factor that determines the final quality of the scanned image. It is important to use the highest quality original document as possible, as enhancement tools may not improve the condition of a poor quality document.

Additionally, the color depth of images that you scan affect the scanning process in different ways. Refer to Understanding Color Depth on page 14 for more information.

Understanding Color Depth

A computer uses units of picture elements, or pixels (also referred to as dots), to represent image information in a digital format. An image file, for instance, is a representation of hundreds, thousands, or millions of pixels arranged
to appear as numbers, letters, or pictures. Computers record the intensity and color of each pixel in 1 or more bits of data. Bits are binary digits—either 0s or 1s—and are the smallest unit of measurement on a computer.

Bit depth, or color depth, describes the number of bits used to represent the color of a single pixel of an image. The greater the bit-depth of an image, the greater the information stored about each pixel. Images can be single-bit, grayscale, or color.

**Single-bit Images**

Single-bit images are the simplest kinds of images, using 1 bit of data to record each pixel. A maximum of 2 colors that can be displayed at any given time for a single-bit image is 2.

There are 2 types of single-bit images—line art and halftone.

Line art images are black and white, such as a photocopy. They may be single color images also—for example, mechanical blueprints or single color drawings and logos. Line art images do not contain any shade of gray.

Halftone images, such as newspaper pictures, are reproductions of images that give the illusion of gray. The black and white dots that make up the image are arranged so that the image appears in shades of gray.

**Grayscale Images**

Grayscale images contain black and white dots as well as shades of gray. More information is encoded in each pixel in a grayscale image than in a black and white image, allowing gray shades to be recorded and displayed.

4 bits of data are needed to reproduce up to 16 levels of gray; 8 bits are needed to reproduce the 256 levels of gray required to accurately represent most black and white photos.

**Color Images**

Color images contain the most complex information. To capture color images, scanners use a process based on the red, green, and blue (RGB) color model, in which red, green, and blue light are combined in various ways to produce a range of colors.

In the RGB model, 0% intensity of each of the red, green, and blue colors creates the color black; 100% intensity of each color create the color white. Equal amounts of red, green, and blue create intermediate shades of gray.

A typical low volume scanner can record and reproduce a large amount of color information—anywhere from 16.7 million colors for 24-bit scanners to 68.7 billion colors for 36-bit scanners. The extra information that can be processed by 36-bit scanners translates to more vivid color reproduction, as the scanners can display more subtle gradations of color to provide images that approach lifelike color accuracy.

**Understanding Resolution**

High resolution is important if you are processing an image through a high-end color system that carries continuous tone data from the scanner through the final film output. High resolution improves the sharpness and clarity of the dots that make up the image.

If the desired output is line art printed on a 1200 dots per inch (dpi) output device, you can interpolate, or scale, the original resolution to up to 1200 dpi, which produces smoother lines and eliminates some of the rough edges in line art scans.
Understanding Dynamic Range

Dynamic range is the ability of a scanner to register a wide range of tonal values from near-white to near-black. A scanner with a good dynamic range can correctly map input shades to output shades so you can see more detail in an image. A scanner with poor dynamic range cannot detect as many tonal values, therefore tending to fill in shadow areas or lose detail in brighter areas.

Most mid-range scanners have a dynamic range capable of registering a wide palette of tones and translating them into photo-realistic color.

Understanding Output File Formats

The size of a scanned image file and, to some extent, its quality, compared to the original size depend on both the resolution in which it is scanned and the file type in which it is saved.

There are many formats available in which to store scanned images, and you can view them in Nolij Web. Refer to Understanding Image File Formats on page 16 and Understanding Non-image File Formats on page 16 for information on available output formats.

Understanding Image File Formats

The following list describes common graphics file formats:

- Tagged Image File Format (TIFF): TIFF is supported by nearly all display and editing applications; therefore, it is recommended that you save images in this format.
- PICT, PICT2: PICT is generally used for line art with limited color, usually 256 colors. PICT2 is used for 8-bit grayscale or 24-bit color images.
- Graphic Interchange Format (GIF): GIF is a highly compressed image format used to store images with 256 unique colors or less.
- Joint Photographic Experts Group (JPG or JPEG): Among the smallest in file size, the JPEG format is used to store large color or grayscale files. However, they suffer from lossy compression, losing data every time they are saved. It is not recommended that you use this format because of degradation of the image quality over time.
- PCX: PCX is a format widely supported in various paint programs and suitable for scanned images.

Understanding Non-image File Formats

Nolij Web can collect and manage both scanned images and electronic documents, allowing you to keep electronic documents in their native file formats for enhanced display and manipulation. Some of the file formats supported include Microsoft Office documents, web content, email, and multimedia.

Before You Scan

To use the scan module, complete the following steps.

1. In the Control Panel, click Programs > Java.
2. In the Java Control Panel, on the General tab, in the Temporary Internet Files section, click Settings.
3. In the **Temporary File Settings**, clear **Keep temporary files in my computer** check box.

4. Click **OK**.

Refer to the following topics for important information you should know before scanning documents:

- **Selecting the Proper Scanning Resolution** on page 17.
- **Selecting Optimal Scanner Settings** on page 17.
- **Using Available Scanning Tools** on page 17.

**Selecting the Proper Scanning Resolution**

Before scanning, choose the appropriate image format and set the desired resolution and scaling. If you have single-color line art, even if it is not black and white, you should scan using the line art setting. For black and white photos, set the scanner to capture as grayscale.

Typically, a resolution of 150 dpi to 240 dpi is appropriate for both display and printing. The higher the resolution setting, the larger the file size of the scanned image.

**Selecting Optimal Scanner Settings**

To determine your optimal scanner settings, it is recommended that you experiment with typical originals until you find the best compromise between quality and file size.

For example, if your sole requirement is to display scanned images on a monitor, you do not need to scan images any higher than at 72 dpi, because monitors are capable of displaying images at 72 dpi only. Conversely, if you must print your scanned images, consider scanning at a resolution between 200 dpi and 300 dpi.

Increasing the scan resolution results in a nonlinear increase in file size. For example, all other variables being equal, the file size of a document scanned at 300 dpi will be over four times larger than the same document scanned at 150 dpi.

**Using Available Scanning Tools**

Most scanner software packages come with image adjustment tools and preconfigured settings to compensate for lower quality originals. It is recommended that you experiment with these adjustments, using a few typical originals, to determine the combination of scanner hardware settings and software adjustments that produce the best results.

Often, brightness and contrast adjustments can improve how the image looks. Additional features, such as the black border removal, deskew, and despeckle are typically available through more robust image processing hardware.

**Retaining Paper**

Ensure that you review and understand your institutional polices for record retention and maintenance. All documents must be kept for the same length of time, whether they are electronic or hard copy.

For example, if an Admissions Office policy states that records must be kept for 10 years, the records should be kept in the imaging system for those 10 years. As long as the integrity of the original document is maintained, it does not matter that the record maintained in the imaging system is electronic.
Imaging and electronic document management standards state that a scanned copy is as acceptable as the hard copy document, as long as you can prove that the electronic document is the source of the decision making for a process.

It is recommended that you maintain original hard copy documents, after scanning them, for a minimum of one full processing period. For example, perform one year's worth of scanning and imaging-related processing using Nolij Web before destroying original documentation. Nolij can assist with archival strategies and storage policy development and implementation.
Before You Begin

Refer to the following topics before you start using Nolij Web:

- Starting and Logging in to Nolij Web on page 19.
- Understanding the User Interface on page 20.
- Understanding Nolij Web Workflow on page 27.
- Understanding Nolij Web User Roles and Privileges on page 27.

Starting and Logging in to Nolij Web

To start and log in to Nolij Web, complete the following steps.

1. Start the application by completing one of the following actions.
   - Open a web browser and type the Nolij Web location. You can type the location in your browser address bar, or you can open it from the browser by selecting File > Open from the browser menu.
   - Double-click the Nolij Web shortcut icon, or (in Microsoft Windows) right-click it and click Open, or (in Apple Mac and Linux) control-click it and click Open.

   By default, there is no shortcut icon. You can create a desktop shortcut, or you can bookmark the startup page, to quickly access it when you subsequently log in to the application.

   To add a shortcut on your desktop, complete one of the following actions.
   - In the browser toolbar, click the browser icon that appears to the left of the Nolij Web URL; then, drag and drop it to the desktop.
   - In Microsoft Internet Explorer, select, from the menu bar, File > Send > Link to Desktop.
   - In Google Chrome, click ⭐ and select Create application shortcuts....

   To bookmark the page, complete one of the following steps.
   - In Internet Explorer, select Favorites > Add to Favorites... from the menu bar. Then, set the bookmark name and location.
   - In Firefox, either select Bookmarks > Bookmark This Page from the menu bar or click ⭐ in the address bar. Then, set the bookmark name and location.
   - In Apple Safari, click + in the address bar. Then, set the bookmark name and location.
   - In Chrome, click ⭐ in the address bar. Then, set the bookmark name and location.

   The log in screen appears.

2. When you log in to Perceptive Nolij Web for the first time, you are prompted to accept the End User License Agreement (EULA). Click Accept to accept the agreement. When you accept the agreement for your user name, it is also accepted for all other roles to which you belong; if you switch to another role, you do not have to accept the EULA again. If you click Decline, you are redirected to the log in screen.
3. Type your user name and password in the Username and Password fields. Your username and password are usually the same as those you use to log in to your administrative system.

   **Note** If there are issues starting Nolij Web or entering data in the login screen, contact your Nolij Web system administrator for assistance in establishing the necessary connection rights and privileges.

4. Click **Log in**.

5. Depending on your configuration, a usage disclaimer dialog box may appear; the usage text is configured by the administrator at the department level. It may appear only one time when you log in and when you change roles, or it may appear every time you log in or change roles.

   **Note** Each user role must accept the disclaimer separately, even if the roles are in the same department.

6. To accept the disclaimer text, check the **I accept** checkbox and click **OK**. If you do not accept the disclaimer, you must click **Logout**; you cannot log in to Nolij Web.

7. If the disclaimer is configured to allow you to choose if you want to display the dialog box to appear only once when you log in or change roles, the **Do not show this again** checkbox appears; check this checkbox if you do not want it to be displayed again when you log in or change roles.

   You are logged in to Nolij Web, and the application starts.

   You are logged in to Nolij Web with your default user role. Specific product functions and features are available depending on the role you use. Refer to **Understanding Nolij Web User Roles and Privileges on page 27**.

   **Note** After a period of inactivity, configured by your Nolij Web administrator, you are prompted that you will be logged out within five minutes of further inactivity.

   **Note** You can log into Nolij Web multiple times.

### Understanding the User Interface

The user interface is customized according to your institution's specifications and for different user roles configured in Nolij Web. The features you can use and panes displayed also depend on whether you use Nolij Web workflows, ImageNow views, or ImageNow workflows.

The following figure shows an example of the Nolij Web interface.
Figure 1: User Interface Elements and Descriptions
The following table describes the user interface elements.

### Table 1: User Interface Elements and Descriptions

<table>
<thead>
<tr>
<th>Callout No.</th>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Toolbar</td>
<td>Contains the following options.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Perceptive button: Provides access to the PDF user guide and also provides information about Nolij Web.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tools menu: Provides access to Nolij Web features.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Communication Window: Allows you to communicate with Nolij Web users.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to Working with the Communication Window on page 122.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Workflow Summary: Allows you to view workflow summary information for Nolij Web workflows only. Refer to Viewing the Workflow Summary on page 83.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Themes: Allows you to change Nolij Web colors. Refer to Changing Themes on page 25.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Preferences: Allows you to configure preferences. Refer to Configuring Preferences on page 25.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ View Reports: Allows you to view configured reports. Refer to Working with Reports on page 119.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ View Advanced Reports: Allows you to view configured advanced reports. Refer to Working with Reports on page 119.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Role selector drop-down box: Allows you to change your user role. Refer to Changing Your Role on page 26 for more information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Logout button: Logs you out of the application.</td>
</tr>
<tr>
<td>2</td>
<td>Document Viewer or</td>
<td>This pane displays either the Document Viewer when you select a document to view it or the Graphical Workflow pane when you view graphical workflow information for Nolij Web workflows.</td>
</tr>
<tr>
<td></td>
<td>Graphical Workflow pane</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to Working with Documents in the Document Viewer on page 99 and Viewing the Graphical Workflow for Nolij Web Workflows on page 78 more information.</td>
</tr>
</tbody>
</table>
The Form pane displays forms, which display SIS information associated with a query folder. Forms can also collect and save information back to the database; later, this information can be retrieved, modified, and resaved to the database. You can view forms for Nolij Web workflows, ImageNow views, and ImageNow workflows. Refer to Working with Forms on page 118 for more information.

This pane displays the folders on your computer or on a network location. After you click a folder, its contents display. Click ▼ to expand folders; click ▲ to collapse them.

You can drag and drop files from the File Explorer pane into Nolij Web if you are using Nolij Web workflows only. If you are using ImageNow workflows or views, you cannot drag and drop files from the File Explorer into Nolij Web.

You can open Nolij Web workflows, ImageNow workflows, ImageNow document views, or ImageNow folder views by selecting the workflow or view from the Workflow/View drop-down box. The view or workflow appears in a separate pane below. The following icons denote the type of workflow or view that you can select.

- : Nolij Web workflow.
- : ImageNow workflow.
- : ImageNow folder view.
- : ImageNow task view.

You can display multiple workflows and views, which appear in separate panes below each other. You can reorder the display by dragging and dropping the workflow or view to the appropriate location.

If you are working in a Nolij Web workflow, the Query Results and Folder Objects panes appear within the Workflow/View area for the workflow.

Refer to the following topics for more information.

- Working with ImageNow Workflows on page 83.
- Working with ImageNow Document Views on page 91.

<table>
<thead>
<tr>
<th>Callout No.</th>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Form pane</td>
<td>The Form pane displays forms, which display SIS information associated with a query folder. Forms can also collect and save information back to the database; later, this information can be retrieved, modified, and resaved to the database. You can view forms for Nolij Web workflows, ImageNow views, and ImageNow workflows. Refer to Working with Forms on page 118 for more information.</td>
</tr>
<tr>
<td>4</td>
<td>File Explorer pane</td>
<td>This pane displays the folders on your computer or on a network location. After you click a folder, its contents display. Click ▼ to expand folders; click ▲ to collapse them. You can drag and drop files from the File Explorer pane into Nolij Web if you are using Nolij Web workflows only. If you are using ImageNow workflows or views, you cannot drag and drop files from the File Explorer into Nolij Web.</td>
</tr>
<tr>
<td>5</td>
<td>Workflow/View area</td>
<td>You can open Nolij Web workflows, ImageNow workflows, ImageNow document views, or ImageNow folder views by selecting the workflow or view from the Workflow/View drop-down box. The view or workflow appears in a separate pane below. The following icons denote the type of workflow or view that you can select.</td>
</tr>
</tbody>
</table>
Accessing the Context Menu for Mobile and Touch Devices

The ▹ appears in certain Nolij Web panes when you are using a mobile or touch device. When you select an item, you can access the context menu for the selected item.

For example, if you want to view document properties in the Folder Objects pane, select the document, click ▹, and select Properties from the menu that appears.

Customizing the Nolij Web Display

You can modify the Nolij Web display in a number of ways, such as resizing panes and moving fields in the Query and Workflow Areas.

When you log out of the application, the Nolij Web layout that is configured becomes the default layout. When you log in again, this layout is used.

You can also change how tables of information show information for Nolij Web dialog boxes that contain tables. Refer to these topics for more information:

- Customizing Dialog Box Displays on page 24.
- Resizing Panes on page 25
- Collapsing and Expanding Panes on page 25.
- Moving Fields in the Nolij Web Workflow Area on page 25.
- Changing Themes on page 25.
- Configuring Preferences on page 25.

Customizing Dialog Box Displays

For Nolij Web dialog boxes that contain tables of information, you can choose the columns of information you want to view or hide, sort information alphabetically, and resize the width of columns.

To select the columns that display and to sort columns:

1. In the dialog box, point your mouse to the edge of a column and click ▼.
2. Click Sort Ascending to sort information alphabetically in a high to low sequence (A to Z).
3. Click Sort Descending to sort information alphabetically in a low to high sequence (Z to A).
4. Click Columns.
5. Check the checkbox for the column you want to display.

To resize the width of a column, point your mouse over the edge of a column until the mouse pointer changes to ‹ ›; then, drag and drop your mouse to the desired location to resize the column.
Resizing Panes

To resize a pane, place your mouse on the edge of a pane. When the mouse pointer changes to (to horizontally resize a pane) or (to vertically resize a pane), click your mouse to select the pane; then, drag and drop the pane to the desired location to resize it.

Collapsing and Expanding Panes

You can collapse and expand several Nolij Web panes. Click to collapse a pane; click to restore it.

Moving Fields in the Nolij Web Workflow Area

You can move fields for Nolij Web workflows only. To do so, place your mouse over a field. When the mouse pointer changes to , you can select the field and drag and drop it to the desired location.

Changing Themes

You can change the colors used in the Nolij Web interface.

1. Select Tools > Themes.
2. From the pop-up menu, click the color scheme you want to use. The theme that you are using is dimmed and unavailable. You can select from the following options:
   - Blue Theme
   - Gray Theme
   - Slate Theme
   - Access Theme

A dialog box appears.

Note Do not click Yes if you have unsaved work that you would like to save before you change the color scheme. If you click Yes, Nolij Web refreshes, and you lose your work.

3. To change the color scheme, click Yes.

   The application refreshes, and the new color scheme is applied.

Configuring Preferences

Hiding Bookmarks

To hide bookmarks in the Document Viewer, select Tools > Preferences > Hide Bookmarks.
Collapsing Inboxes and Queues in Drop-Down Boxes

You can specify that Nolij Web display inboxes in Nolij Web workflows and queues in ImageNow workflows in a drop-down box from which you can select the inbox or queue to display. If you do not set this preference, the last configuration of inboxes and queues is displayed when you open a workflow.

To collapse inboxes and queues by default, select **Tools > Preferences > Inboxes/Queues in dropdown by default.**

If inboxes or queues are collapsed, you can expand them by clicking the ➔ button; if they are expanded, you can collapse them by clicking the ◀ button.

Resetting Preferences

**Note** When you reset preferences, you are logged out of Nolij Web.

To reset your preferences, select **Tools > Preferences > Reset Preferences.**

Your preferences are reset to default preferences, and you are logged out of the application.

Changing Your Role

To change your user role, do the following.

1. Select the role in which you want to work from the Role drop-down box in the toolbar. The drop-down box contains all of the roles to which you belong.

2. Depending on your configuration, a usage disclaimer dialog box may appear; the usage text is configured by the administrator at the department level. It may appear only one time when you log in and when you change roles, or it may appear every time you log in or change roles.

   **Note** Each user role must accept the disclaimer separately, even if the roles are in the same department.

3. To accept the disclaimer text, check the **I accept** checkbox and click **OK.** If you do not accept the disclaimer, you must click **Logout;** you cannot log in to Nolij Web.

4. If the disclaimer is configured to allow you to choose if you want to display the dialog box to appear only once when you log in or change roles, the **Do not show this again** checkbox appears; check this checkbox if you do not want it to be displayed again when you log in or change roles.

   The application refreshes, and the user interface for the role in which you are working appears.

For more information about user roles, see **Understanding Nolij Web User Roles and Privileges on page 27.**
Understanding Nolij Web Workflow

Workflow is the automatic process by which the electronic information in Nolij Web is sent from one user to another. An example Nolij Web workflow might involve the following tasks:

1. Applications are received by a clerk, who verifies that all required documents are present.
2. When Step 1 is complete, applications are sent to an assistant who reads the documents.
3. When Step 2 is complete, applications are sent to a director for final approval.

Nolij Web represents this information as virtual folders, which contain the documents associated with records of information.

Folders are routed to inboxes in the Workflow area. You can route a folder manually, or a folder can be routed automatically, based on the Nolij Web configuration for your institution.

In an automatic workflow, when you click ✔️ in the Query Results pane or select Work Complete from the folder’s right-click menu in the Query Results pane, the workflow process starts, and Nolij Web routes the folder to the appropriate inbox when the proper conditions are met.

For example, a workflow may require that a folder contain an essay, transcript, and application before it can be routed to the next inbox. If a folder contains all documents, it is passed to the next inbox; however, if the folder does not have all required documents, it will not be passed along in the workflow.

You can override the automatic workflow process for a folder for which you have the appropriate privileges by selecting, from the drop-down box that contains all the inboxes to which you can route folders, the inbox to which the folder is routed next.

Nolij Web does not send information along in the workflow if any conditions are not satisfied, and it alerts you if this is the case.

See the appropriate ImageNow documentation for information about ImageNow workflow processes when you are using ImageNow workflows and views.

Understanding Nolij Web User Roles and Privileges

When you log into Nolij Web, you are logged in to the application with your default role. What you can do with Nolij Web is dependent upon your user role, to which a collection of privileges is assigned. These privileges determine the features you can access and the tasks that you can perform.

The following list describes the tasks that you can perform when you have the appropriate privileges when you work in Nolij Web workflows.

- Search for documents using keywords.
- View reports.
- View and use forms.
- Collaborate with other users.
- View and use specific inboxes.
- Override the workflow process by manually routing folders to any inbox you can access.
• View specific documents in a query folder (including the types of files you can view).
• Edit, annotate, and scan documents.
• Drag and drop files from the Nolij Web File Explorer into a query folder.
• Delete and rename documents in query folders.
• Recover deleted documents.
• Index documents (including selecting and viewing the indexes you can use).
• Print and email documents.
• Open a document in the application that is designated to open the particular type of file (for example, an HTML file opens in Microsoft Internet Explorer, if Internet Explorer is specified as the application that opens HTML files).
• Lock query results.
• Remove folders from the workflow.
• View and use stamps.
• Set custom statuses.
• Create a copy of a template document.
• Create versions of documents.
• Automatically index documents.

In addition, your Nolij Web privileges and your ImageNow permissions for ImageNow workflows and views determine if you can work within ImageNow workflows and views.
Using Nolij Web

The features you can use depend on whether you are working in Nolij Web workflows, ImageNow workflows, or ImageNow views. Your administrator can configure Nolij Web to allow you to access ImageNow workflows and views through the Nolij Web interface. You must have the appropriate permissions for these workflows and views in ImageNow to work with them in Nolij Web. All work you perform in ImageNow workflows and views occurs in ImageNow; Nolij Web only serves as the method by which you can access them.

Note You can set preferences to collapse Nolij Web workflow inboxes or ImageNow workflow queues; refer to Collapsing Inboxes and Queues in Drop-Down Boxes on page 26 for more information.

Refer to these topics for information.

- **Using Nolij Web with Nolij Web Workflows on page 29** for information about what you can do in Nolij Web workflows only.
- **Working with ImageNow Workflows on page 83** for information about what you can do in ImageNow workflows only.
- **Working with ImageNow Document Views on page 91** for information about what you can do in ImageNow document views only.
- **Working with ImageNow Folder Views on page 95** for information about what you can do in ImageNow folder views only.
- **Working with ImageNow Task Views on page 96** for information about what you can do in ImageNow task views only.
- **Working with Forms on page 118** for information about working with forms. Forms can be configured for Nolij Web workflows, ImageNow document views, and ImageNow workflows.
- **Working with Reports on page 119** for information about working with reports. Reports can be configured for Nolij Web workflows, ImageNow views, and ImageNow workflows.
- **Working with the Communication Window on page 122** for more information about communicating with Nolij Web users. The Communication Window is available for all users in Nolij Web.

Using Nolij Web with Nolij Web Workflows

Refer to the following topics for more information about what you can do when you work with Nolij Web workflows. You cannot use these features if you are working in ImageNow document views, folder views, or workflows.

- **Understanding the Nolij Web Workflow Pane on page 31**.
- **Performing Nolij Web Queries on page 34**.
- **Searching All Documents for Specified Text on page 39**.
- **Configuring How Query Results are Displayed on page 40**.
• Clearing Query Results on page 41.
• Locking Query Results on page 41.
• Locking Query Folders on page 41.
• Locking Documents on page 41.
• Adding Favorite Folders on page 41.
• Viewing the Folder History on page 42.
• Setting Custom Statuses for Folders on page 42.
• Uploading Files to Folders on page 43.
• Viewing the Folder Objects Pane on page 43.
• Opening Documents in the Folder Objects Pane on page 45.
• Opening Documents in New Windows on page 45.
• Scanning Documents on page 46.
• Creating Document Versions on page 51.
• Indexing Documents on page 52.
• Modifying ImageNow Document Properties in Nolij Web Workflows on page 54.
• Viewing Nolij Web Document Properties on page 54.
• Viewing Version Properties on page 57.
• Renaming Documents on page 59.
• Deleting Documents on page 60.
• Recovering Deleted Documents on page 60.
• Duplicating Documents on page 61.
• Merging Documents on page 61.
• Moving Documents into Query Folders on page 61.
• Moving Documents into Subfolders on page 62.
• Emailing Documents on page 62.
• Searching for Documents in the Folder Objects Pane on page 64.
• Adding Template Documents on page 65.
• Adding and Emailing Template Documents on page 66.
• Importing Emails into the Folder Objects Pane on page 71.
• Moving Folders in a Nolij Web Workflow on page 76.
• Viewing the Graphical Workflow for Nolij Web Workflows on page 78.
• Viewing the Workflow Summary on page 83.

Understanding the Nolij Web Workflow Pane

The Nolij Web workflow pane contains the inboxes that contain the folders with which you can perform work. This pane also contains fields in which you perform a query. Type the information that you want to find in the appropriate fields. For more information about performing queries, refer to Performing Nolij Web Queries on page 34.

From the Workflow/View drop-down box, select the Nolij Web workflow in which you want to work. The icon next to the name of the menu option in the Workflow/View pane denotes that the option is a Nolij Web workflow.

Figure 2: Nolij Web Workflow Elements
### Table 2: Nolij Web Workflow/View Pane Elements and Descriptions

<table>
<thead>
<tr>
<th>Callout No.</th>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Workflow toolbar</td>
<td>Contains the name of the Nolij Web workflow in which you are working. In the preceding figure, Admissions Process is the name of the workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>It also provides buttons to allow you to view the graphical workflow and to clear query fields. Refer to</td>
</tr>
<tr>
<td>2</td>
<td>Query fields</td>
<td>Query fields that you can use to search for records of information.</td>
</tr>
<tr>
<td>3</td>
<td>Inboxes</td>
<td>Inboxes that you own. Refer to Working with Nolij Web Inboxes on page 33 for more information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> Inboxes can be expanded or collapsed, depending on your preferences. Refer to Collapsing Inboxes and Queues in Drop-Down Boxes on page 26 for more information.</td>
</tr>
<tr>
<td>4</td>
<td>Folder Objects pane</td>
<td>Displays the objects contained in a Nolij Web query folder. Its contents are displayed after you click the containing folder in the Query Results pane.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can do the following.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View documents in a query folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Index documents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete and rename documents in a query folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Email documents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Search documents for specified text.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Add template documents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View and configure document properties.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Open multiple documents in new windows.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This pane does not appear for ImageNow document views, folder views, or workflows.</td>
</tr>
<tr>
<td>5</td>
<td>Query Results pane</td>
<td>Query Results pane: This pane contains the results of your Nolij Web query. Click ‹ to collapse the results; click › to expand the results. This pane is displayed for Nolij Web workflows only; it does not appear for ImageNow document views, folder views, or workflows.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the toolbar, you can also access features to specify that work is complete on a folder, clear query results, and configure how query results are displayed.</td>
</tr>
</tbody>
</table>
Working with Nolij Web Inboxes

The Nolij Web Workflow/View displays inboxes that you own; they contain the folders of documents with which you can perform work, such as renaming and annotating documents. The number of folders in each inbox appears in parentheses ( ) next to each inbox name.

In the preceding figure, 1st Read, 2nd Read, Completed Evaluation, Final Evaluation, and Validate Checklist are the inboxes you own.

When you click a folder in the Query Results pane, the inbox that contains the folder appears next to the Current Inbox label.

If you click a folder that is not in your workflow or any other workflow, Not in Workflow appears next to the Current Inbox label.

If you have permission to move folders to another inbox, you can click the drop-down arrow for the inbox that contains the folder you selected in the Query Results pane. When you select Move To, the inboxes to which you can send folders (if you are permitted to do so in Nolij Web), appear in the drop-down box. If you do not have the appropriate privileges, the Move To option is unavailable.

In the following figure, you can move folders from the 1st Read inbox to the 1st Read, 2nd Read, Completed Evaluation, Final Evaluation, and Validate Checklist inboxes.

Figure 3: Move To Drop-Down Box

When inboxes are collapsed and a folder moves into a new inbox, the icon appears next to the inbox to indicate that there are changes that have not been seen to the inboxes in the drop-down box. When you click the inbox drop-down box, the icon appears next to the inbox into which the folder was moved.

When a folder is moved into an inbox and changes have not yet been viewed when inboxes are expanded, the icon appears next to the inbox.

After you have viewed changes to the inbox, the icon no longer appears next to the inbox.

Click an inbox to view information about the folders in the Inbox Detail dialog box.
Inboxes display the Folder and Date columns. Depending on your configuration, the query fields used to find the folders are also displayed. The Custom Status column is displayed if you have permission to set custom statuses for folders in your inbox.

**Note** The Inbox Detail dialog box may not display all folders in an inbox, depending on your configuration. For example, if you run a query to retrieve student records, but the query is configured to return records for students’ whose last names begin with A through M only, then records for students’ last names begin with N - Z are not displayed. However, the number of folders in each inbox that appears in parentheses ( ) next to each inbox name indicates the total number of folders in the inbox, including all records from A - Z.

In the Inbox Detail dialog box, you can perform any of the following actions.

- Open a folder by completing one of the following actions.
  - Right-clicking the folder and selecting **Open** from the pop-up menu.
  - Selecting the folder and clicking **Open**.
  - Double-clicking the folder.

  The folder is displayed in the Query Results pane.

- Move a folder to the next inbox. Refer to Moving Folders in a Nolij Web Workflow on page 76.
- View folder history details. Refer to Viewing the Folder History on page 42.
- Remove a folder from your workflow. Refer to Removing Folders from the Workflow on page 78.
- Set a custom status for the folder. Refer to Setting Custom Statuses for Folders on page 42.

Folders in inboxes are sorted by the date on which they were added, with the most recently added folder appearing at the top of the list. In the Inbox Detail dialog drop-down box, you can type the name or portion of the name of the folder with which you want to work; folder results are filtered in the dialog box.

**Note** The Inbox Detail dialog box displays a specified number (determined by your Nolij Web administrator) of folders at one time. If there are more than the specified number of folders, the list is separated into multiple pages, with each page containing up to the specified number of folders. Use the arrows at the bottom of a page to navigate to the first, last, previous, or next page.

**Note** For inboxes that also display query fields, you cannot sort information if results are displayed on more than one page in the Inbox Detail dialog box.

**Performing Nolij Web Queries**

Use Nolij Web to query records to access electronic content, such as scanned images and other types of digital content, from your Nolij Web repository. You can search for information based on criteria, such as date of birth, name, and address. Nolij Web displays the information retrieved from a query as folders, which contain all documents associated with the record of information.

**Note** Depending on your Nolij Web configuration, a legal hold may be placed on a folder, and you may not be permitted to view contents of the folder. A dialog box may appear with text containing information about the legal hold when you click a folder on which the hold is configured.
To perform a query, complete the following steps.

1. From the Workflow/View drop-down box, select the Nolij Web workflow in which you want to work. The Workflow pane appears for the Nolij Web workflow below.

2. In the search fields, set the appropriate values, or part of the value, for the data that you want to find.
   
   In text fields, you can use the % sign as a wildcard to broaden searches if you do not have all of the required information. Use this value in a search term to represent one or more other characters.
   
   For example, you may not know if the applicant Joe Smith used the name Joseph, Joey, or Joe as the name on his application. To query his record, you can type Smith in the Last Name text field and J% in the First Name text field. The results of the query show all applicants with the last name Doe and the first letter J (for example, Joe and Jane).
   
   For information on searching for documents containing specified text, refer to Searching All Documents for Specified Text on page 39.

   Note If you have multiple queries, the fields for a query that is not in use are dimmed.

3. After setting the search criteria, press Enter on your keyboard.
   
   The results are displayed as virtual folders in the Query Results pane. Click ▼ to collapse the results; click ▶ to expand them.

   When you perform a query to find a folder, the name of your query, configured by your Nolij Web administrator, appears and contains all the folders found by the query in the Query Results pane.

   In addition, a number is appended to the name of the query, which denotes the order of the searches performed. For example, for the first query you perform, 1 is appended, for the second query, 2 is appended, and so on.

   Note The Query Results pane displays 100 results at a time. If the query returns more than 100 results, the first 100 are displayed.

   You can open folders in an inbox and display them by doing the following:

   1. Click an inbox. The Inbox Detail dialog box appears.

   2. Open a folder by completing one of the following actions.
      
      o Right-clicking the folder and selecting Open from the pop-up menu.
      
      o Selecting the folder and clicking Open.
      
      o Double-clicking the folder.

      The folder is displayed in the Query Results pane.

   When you open a folder that is in an inbox in your workflow, Workflow folder appears and contains the folder found by the query in the Query Results pane.

   In addition, a number is appended to Workflow folder, which denotes the order of the searches performed. For example, for the first batch query you perform, 1 is appended, for the second query, 2 is appended, and so on.
Performing Subindex Queries

In a typical Nolij Web query, documents are associated with a primary value, such as a name, and are associated with a single folder. However, subindexed documents are associated with a secondary value. Examples of subindexed documents could include gifts received from donors and invoices received from purchase orders.

For instance, for a query that displays all gifts associated with a donor, the folder represents the primary value to which a gift is associated, such as the name of the donor. The subindex represents the secondary value to which a gift is associated, such as the gift number.

When you perform a subindex query to find a folder, the name of your query, configured by your Nolij Web administrator, appears and contains all the folders found by the query in the Query Results pane.

In addition, a number is appended to the name of the query, which denotes the order of the searches performed. For example, for the first subindex query you perform, 1 is appended, for the second query, 2 is appended, and so on.

In subindex queries, the first query field that is displayed in the Query area is used as the subindex—the secondary value to which a document is associated—for which you search. This field is used as the label for the subindex in the Query Results pane.

For example, in the following figure, Gift # is the subindex field. Gift # is used as the label for the subindex within a folder. For instance, for the subindex 1850001, 1850001 is a Gift #.

Figure 4: Subindex Field Example

If you use only the first query field to perform a subindex query, a icon appears next to the query results in the Query Results pane. The query returns results for only the subindex that matches the value entered into the first query field.

For example, if you type 1850001 in the Gift # field, results are returned for only the 1850001 subindex.
Figure 5: Subindex Query Results Using First Query Field

If you use any other query field to perform subindex query, a icon appears next to the query results in the Query Results pane. All of the subindexes and documents associated with the folder are displayed.

For example, if you type Doe into the Last Name field, all results associated with the folder are displayed.

Figure 6: Subindex Query Results Using Other Query Fields

If a document is associated with the subindex, the Query Results pane displays the subindex with the icon. If no documents are associated with the subindex, it is displayed with the icon.

In a subindex document query, when you add a document to a subindex, the document is automatically associated with the subindex, and its document type changes accordingly.

For example, if you add the document Donation.pdf to the subindex 1850001, Donation.pdf is automatically assigned the document type Gift, which is the value of the 1850001 subindex. Additionally, the document is renamed to 1850001 Gift (for more information about renaming documents, refer to Renaming Documents on page 59.)
Performing Batch Queries

Batch folders are used to store documents that are not associated with any particular record, such as batches of scanned documents or miscellaneous documents. If your institution has batch queries configured, you can search for a batch folder using the appropriate field.

Typically, batch folders are not associated with workflows, and folders cannot be routed to other inboxes—they are static folders.

To search for a batch folder, select the batch folder from the batch query drop-down box. The results are displayed in the Query Results pane. When you perform a batch query to find a folder, the name of your batch, configured by your Nolij Web administrator, appears and contains all the folders found by the query in the Query Results pane.

In addition, a number is appended to the name of the query, which denotes the order of the searches performed. For example, for the first batch query you perform, 1 is appended, for the second query, 2 is appended, and so on.

Creating New Batch Folders

To create a new batch folder, complete the following steps.

1. From the Workflow/View drop-down box, select the Nolij Web workflow in which you want to work. The Workflow pane appears for the Nolij Web workflow below.

2. In the batch query field, type the name of the batch folder you want to create. The Create New Record dialog box appears.

3. To create a new batch folder, click Yes.

4. Press Enter on your keyboard.

   The batch folder is created and is displayed in the Query Results pane.

After you have created a batch folder, you can add documents to the folder by doing any of the following:

- Uploading system objects to the batch folder. Refer to Uploading Files to Folders on page 43.
- Moving folder objects from a folder to the batch folder. Refer to Moving Documents into Query Folders on page 61.
- Scanning documents and adding them to the batch folder. Scanning Documents Into Query Folders or Subfolders on page 46.
Renaming Batch Folders

To rename a batch folder, complete the following steps.

1. Right-click the batch query folder.
2. Select **Rename** from the pop-up menu.
   
The Rename dialog box appears.
3. Type a name for the batch folder and click OK.
   
The batch folder is renamed and appears in the Query Results pane.

Deleting Batch Folders

To delete a batch folder, in the Query Results pane, right-click the batch folder and click **Delete Batch Folder**. The folder is deleted and is removed from the Query Results pane.

**Note** You cannot delete a batch folder if there are documents in it. You must first delete all documents and then delete the batch folder.

Clearing Queries

To clear query information in the query fields of the Nolij Web workflow, click \[\] in the toolbar of the Workflow pane.

Searching All Documents for Specified Text

You can search all documents in Nolij Web for specified text (**context search**), if Nolij Web is configured to perform OCR on specified documents.

**Note** This procedure discusses how to search for all documents in Nolij Web using specified text. To perform a search for only those documents located in the Folder Objects pane for a specific folder, refer to Searching for Documents in the Folder Objects Pane on page 64.

**Note** When you add a document to a folder, and Nolij Web is configured to perform OCR on the document type, Nolij Web automatically performs OCR on the document; you can then search for the document using the text contained in it.

To search for documents containing specific text, complete the following steps.

1. In the document search field in the Query area of the toolbar, type the specified text. Optionally, you can set other search criteria, such as name or address.
2. Press **Enter** on your keyboard.
   
   Nolij Web searches all documents, in the folders that match your search criteria, that contain the specified text. The Query Results pane displays the results of the search. It shows the folders that contain the documents having the specified text, and it displays the documents (up to 5 at one time) that contain the text as subentries in each folder.
For example, if you search for the word application, the Query Results pane displays the folders that contain the documents with the word *application*; the specific documents that contain *application* are shown as subentries under the corresponding folders.

The results in the Query Results pane display only the documents that contain the text for which you searched. When you click a folder, the Folder Objects pane displays only the documents that contain the text for which you searched; it does not display all documents in a folder.

If you click a document, containing the text for which you searched, in the Query Results pane, you see only documents that contain the searched text in the Folder Objects pane.

Note that the search field in the Folder Objects pane is dimmed, showing the text used in the search.

When you click a query result, folder, or document, the icon appears in the toolbar in the Query Results pane. Click the icon to open the Ranked Results dialog box, which displays the following information for all results returned by the search:

- Name: Name of the document.
- Rank: The ranking of the search result based on its relevance.
- Folder: Folder containing the document.

To show ranked results, click and check the Display Ranked Results checkbox.

**Note** You can click a document in the dialog box to display it in the Folder Objects pane and view it in the Document Viewer.

Click Close to close the dialog box.

Configuring How Query Results are Displayed

In the Query Results pane, click to open a pop-up menu that allows you to configure certain display options. Refer to the following table for more information.

<table>
<thead>
<tr>
<th>Click This...</th>
<th>To Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear All Results Before Each Query</td>
<td>Clear all query results from the Query Results pane each time before a new query is performed.</td>
</tr>
<tr>
<td>Expand All</td>
<td>Expand the results in the Query Results pane.</td>
</tr>
<tr>
<td>Collapse All</td>
<td>Collapse the results in the Query Results pane.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Clear all query results in the Query Results pane.</td>
</tr>
</tbody>
</table>
Clearing Query Results

Click ☒ in the Query Results pane to clear results for queries that are not locked and are not favorite folders.

Locking Query Results

To lock query results, right-click the query results and click **Lock Query Results**. A lock icon 🗝️ appears next to the query results to indicate that it is locked.

Locking query results prevents the Query Results pane from being cleared completely when you click ☒ or when you run another query with the Clear All Results Before Each Query option enabled.

To unlock query results, right-click the query results and click **Unlock Query Results**.

Locking Query Folders

Your user role determines if you can lock query folders. For more information, refer to Understanding Nolij Web User Roles and Privileges on page 27.

When you select a folder that is not locked by another user, you lock the folder for your own use. Other users can see folder contents but cannot make any changes. If you select a folder locked by another user, Nolij Web displays a message stating that the folder is locked and changes cannot be made.

Locking Documents

Your user role determines if you can lock documents. For more information, refer to Understanding Nolij Web User Roles and Privileges on page 27.

When you select a document in a folder that is not locked by another user, you lock the document for your own use. Other users can see the document but cannot make any changes. If you select a document locked by another user, Nolij Web displays a message stating that the document is locked and changes cannot be made. If a query folder has other documents, other users can modify those documents.

Adding Favorite Folders

To set a folder as a favorite folder in the Query Results pane, right-click the folder and select **Add Favorite**.

A Favorite Folders label and lock icon 🔄️ Favorite Folders appear at the top of the Query Results pane.

Favorite folders are locked, preventing the Query Results pane from being cleared when you click ☒ in the Query Results pane or when you run another query with the Clear All Results Before Each Query option enabled.

To remove a favorite folder, right-click the folder and select **Remove Favorite**. The folder is removed from Favorite Folders.
Viewing the Folder History

To view folder history information, which provides information about the movement of a folder through your workflow, do one of the following:

- Right-click the folder in the Query Results pane; then, select **History** from the pop-up menu.
- Click an inbox in the Workflow area; then, right-click the folder in the Inbox Detail dialog box and select **History** from the pop-up menu.

The Folder History dialog box appears and displays the following information about the folder:

- **User**: Username of the user who sent the folder to the destination inbox.
- **Source Inbox**: Inbox from which the folder was sent.
- **Destination Inbox**: Inbox to which the folder was next sent.
- **In**: Time and date on which the folder was received in the inbox.
- **Out**: Time and date on which the folder was sent from the inbox.

History is not displayed for folders not in your workflow or any other workflow.

Setting Custom Statuses for Folders

You can set a custom status, which consists of a label and color, to a folder. The statuses you can set for a folder depend on your Nolij Web configuration.

For example, custom statuses can be used to set reminders for tasks you need to complete for a folder.

Your user role determines if you can set custom statuses on folders. For more information about roles, refer to **Understanding Nolij Web User Roles and Privileges on page 27**.

1. Click an inbox in the Workflow pane.
   - The Inbox Detail dialog box appears.
2. Right-click the folder in the dialog box and select **Custom Status** from the pop-up menu. To select multiple folders:
   - Click a folder and press and hold the **Ctrl** key as you click each folder.
   - Click a file and press and hold the **Shift** key as you click another folder to select contiguous folders.
3. Select the status from the pop-up menu.
   - The status is applied to the folder, and the Custom Status column refreshes to display the color and label for the status.

To remove a custom status, right-click the folder (or select multiple folders and right-click them) and select **None** from the pop-up menu.
Uploading Files to Folders

Your user role determines if you can upload system files to a folder and the types of files you can upload. For more information about roles, refer to Understanding Nolij Web User Roles and Privileges on page 27.

You can upload files of various types—for instance, word processing, text, audio, and video—to a folder by doing the following:

1. In the Query Results pane, click the folder to which you want to upload a file.
2. Click the file you want to add in the File Explorer pane. To select multiple files:
   - Click a file and press and hold the Ctrl key as you click each file.
   - Click a file and press and hold the Shift key as you click another file to select contiguous files.
3. Drag and drop the file into either the Folder Objects pane or the Query Results pane. You do not need to select a folder in the Query Results pane if you want to upload a file to it.

   The file is uploaded into the folder.

Viewing the Folder Objects Pane

Documents are displayed in the Folder Objects pane in a table that contains the following columns:

- **Type**: Displays the appropriate icon for the type of file (for example, JPEG or PDF).
- **Name**: Name of the file. For more information about filenames, refer to Renaming Documents on page 59.
- **Created**: Date that the document was created.
- **Created by**: Username of the user who created the document.
- **Modified**: Date that the document was modified.
- **Modified by**: Username of the user who modified the document.
- **Size**: Size of the document.
- **Version**: For documents with versioning enabled, the latest version of the document.
- **Custom Property**: If custom properties are set, custom property of the document.

You can refresh the pane to view the most current information by clicking 🔄.

**Note** When you sort information in columns or resize the width of columns, these settings are saved as preferences and are applied the next time you log in to Nolij Web.

If subfolders are configured, and your privileges allow you to view them, the pane contains a tab for each subfolder. Click a tab to display the contents of the subfolder. The All tab displays all documents in the folder, and documents that belong to a subfolder are labeled in blue.

Global documents are labeled in bold red for departments that did not create them; they are labeled in bold text when viewed by roles that created them. For more information about global documents, refer to Setting Global Documents on page 53.
Shared documents are labeled in red for departments that did not create them. For more information about shared documents, refer to Setting Shared Documents on page 54.

Table 4: Document Icons and Descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📄</td>
<td>OCR is not configured on the document; the document is not indexed.</td>
</tr>
<tr>
<td>📄</td>
<td>OCR is pending on the document; the document is not indexed.</td>
</tr>
<tr>
<td>📄</td>
<td>The document is indexed, and OCR is pending on the document.</td>
</tr>
<tr>
<td>📄</td>
<td>OCR has completed on the document; the document is not indexed.</td>
</tr>
<tr>
<td>📄</td>
<td>OCR has completed on the document but did not meet OCR success requirements; the percentage of recognized words does not meet the percentage of words, defined by your Nolij Web administrator, that OCR must recognize on a document for OCR to be successful.</td>
</tr>
<tr>
<td>📄</td>
<td>The document is indexed.</td>
</tr>
<tr>
<td>📄</td>
<td>The document is indexed; OCR did not meet success requirements.</td>
</tr>
</tbody>
</table>
Opening Documents in the Folder Objects Pane

Click a document in the Folder Objects pane to display the document in the Document Viewer, where you can annotate it (refer to Working with Documents in the Document Viewer on page 99 for more information).

You can view the following types of files:

- GIF
- TIFF
- JPEG
- HTML
- DOC (Microsoft Word)
- RTF (rich text file)
- PPT (Microsoft PowerPoint)
- XLS (Microsoft Excel)
- TXT
- BMP

To open all other types of files, double-click the file in the Folder Objects pane. The file is opened in the application designated to open the particular file type (referred to as application activation). For example, an MP3 file opens in Apple iTunes if iTunes is specified as the application that opens MP3 files).

**Note** You cannot see annotations if you open a file in an application other than Nolij Web.

Opening Documents in New Windows

You can open multiple documents in new windows, for example, for side-by-side comparison. In the Folder Objects pane, right-click the document and select **View in New Window**. The document displays in a standalone Document Viewer in a new window in view-only mode.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>The document could not be auto-indexed.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>The document could not be auto-indexed, and OCR did not meet success requirements.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>The document is auto-indexed and moved to the appropriate folder.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>The document is auto-indexed and moved to the appropriate folder; OCR did not meet success requirements.</td>
</tr>
</tbody>
</table>

Table 4: Document Icons and Descriptions (Continued)
Scanning Documents

- To start scanning as you click , the Scanning status box appears.

Note: The Scanning status box automatically closes after few seconds, if the scan has not started.

Refer to these topics for more information:
- Scanning Documents Into Query Folders or Subfolders on page 46.
- Rescanning Pages on page 50.
- Adding Scanned Pages to Documents on page 50.

Scanning Documents Into Query Folders or Subfolders

After you have performed a query, you can scan documents into the folder.

Note: To scan paper documents into Nolij Web, you must have a TWAIN-compliant scanner attached to your machine and the appropriate TWAIN drivers installed.

Refer to these topics for more information:
- Scanning Single-Page Documents on page 46.
- Scanning Multipage Documents on page 47.
- Scanning Using Blank Page Detection on page 47.

Scanning Single-Page Documents

To scan a single page, complete the following steps.

1. In the Query Results pane, click the folder into which you want to add a scanned document.
2. To scan a document into a subfolder, click the subfolder in the Folder Objects pane.
3. In the Folder Objects pane, click . The NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

Note:
- If you do web scan without the Java plug-in, in the Firefox browser, as you click after you log in to Nolij Web, Opening launch.jnlp dialog box appears. By default, Open with option is selected. Click OK. Launch.jnlp file is automatically downloaded and NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

- If you do web scan without the Java plug-in, in the Internet Explorer, as you click after you log in to Nolij Web, Launch.jnlp file is automatically downloaded and NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

- If a default scanner is configured, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.
You can change the default scanner. For more information, refer to Changing the Default Scanner on page 51.

When scanning starts, a progress bar appears. You cannot perform any other Nolij Web activity while the progress bar is displayed.

The document is scanned into the folder and is stored on the file server. After scanning completes, Nolij Web displays a pop-up message, which, in the lower rightmost corner of the application, displays the number of pages scanned.

### Scanning Multipage Documents

You can scan multipage TIFF images and save them as a single document.

1. In the Query Results pane, click the folder into which you want to add a scanned document.
2. If you want to scan a document into a subfolder, click the subfolder in the Folder Objects pane.
3. In the toolbar, click the drop-down menu next to the button and check the Multi Page checkbox.
4. To enable Nolij Web to detect blank pages, which function as document breaks and creates merged, and multipage documents, refer to Scanning Using Blank Page Detection on page 47.
5. Click . The NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

**Note**:

- If you do web scan without the Java plug-in, in the Firefox browser, as you click after you log in to Nolij Web, `Opening launch.jnlp` dialog box appears. By default, **Open with option** is selected. Click OK. `Launch.jnlp` file is automatically downloaded and NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

- If you do web scan without the Java plug-in, in the Internet Explorer, as you click after you log in to Nolij Web, `Launch.jnlp` file is automatically downloaded and NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

- If a default scanner is configured for your login session, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.

  You can change the default scanner; for more information, refer to Changing the Default Scanner on page 51.

When scanning starts, a progress bar appears. You cannot perform any other Nolij Web activity while the progress bar is displayed.

The document is scanned into the folder and is stored on the file server. After scanning completes, Nolij Web displays a pop-up message, which, in the lower rightmost corner of the application, displays the number of pages scanned.

### Scanning Using Blank Page Detection

You can enable Nolij Web to detect blank pages, which function as document breaks. You can scan a stack of documents with blank pages separating the documents. When Nolij Web detects blank pages, it creates separate
scanned documents, with each document split based on blank pages. Blank pages are not kept as part of any document.

For example, if you place six pages on a scanner, and page 3 is a blank page, the scan process produces two documents. The first document consists of pages 1 and 2, and the second document consists pages 4, 5, and 6.

**Note** You do not need to provide blank pages for the first or last pages in the scanned documents.

**Note** For double-sided documents, Nolij Web does not use blank pages on the back sides of the pages you scan as page separators. They are considered regular pages and are added to the document.
To detect blank pages:

1. In the Query Results pane, click the folder into which you want to add a scanned document.
2. If you want to scan a document into a subfolder, click the subfolder in the Folder Objects pane.
3. In the toolbar, click the drop-down menu next to and check the Multi Page checkbox.
4. In the toolbar, click the drop-down menu next to and check the Enable Blank Page Detection checkbox.
5. In the toolbar, click the drop-down menu next to , select Enable Blank Page Detection, and select Set Threshold.

The Blank Page Threshold dialog box appears.
6. Set the threshold that Nolij Web uses to determine if a page is blank. Even blank pages may have dots in the background that you do not want to scan; set the threshold, which is the ratio of white to non-white pixels (noise) that a page can have, so that Nolij Web can detect which pages you scan are blank or not blank.

The values on the slider continuum range from 0 (zero) to 100. Set the value by clicking the slider and dragging and dropping it to the desired location or by clicking the location to which to move the slider.

Move the slider left to decrease the threshold or move the slider right to increase the threshold. You should use lower values for newer, cleaner scanners that are capable of removing noise. An appropriate setting for high-quality scanners ranges from 40 to 50. You should use higher values for older scanners with reduced capability for removing noise.
7. Click OK.
8. Click . The NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

Note:

- If you do web scan without the Java plug-in, in the Firefox browser, as you click after you log in to Nolij Web, Opening launch.jnlp dialog box appears. By default, Open with option is selected. Click OK. Launch.jnlp file is automatically downloaded and NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

- If you do web scan without the Java plug-in, in Internet Explorer, as you click after you log in to Nolij Web, Launch.jnlp file is automatically downloaded and NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

- If a default scanner is configured for your login session, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.

You can change the default scanner. For more information, refer to Changing the Default Scanner on page 51.

When scanning starts, a progress bar appears. You cannot perform any other Nolij Web activity while the progress bar is displayed.
The document is scanned into the folder and is stored on the file server. After scanning completes, Nolij Web displays a pop-up message, which, in the lower rightmost corner of the application, displays the number of pages scanned.

Rescanning Pages

Your user role determines if you can rescan pages. For more information about roles, refer to Understanding Nolij Web User Roles and Privileges on page 27.

You can rescan a page and replace the page in a Nolij Web document with the rescanned page. The document must be in TIFF format.

1. In the Folder Objects pane, select the document that you want to replace.
2. In the Document Viewer, navigate to the page that you want to replace with the rescanned page.
3. Right-click anywhere in the Document Viewer and select Rescan Page from the pop-up menu.

   • If you are using web scan without the Java plug-in, after performing the above task described in step 3, in Firefox browser, Opening launch.jnlp dialog box appears. By default, Open with option is selected. Click OK. Launch.jnlp file is automatically downloaded and NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

   • If you are using web scan without the Java plug-in, after performing the above task described in step 3, in Internet Explorer, Launch.jnlp file is automatically downloaded and NolijWeb Scan dialog box appears which prompts you to select the specific scanner from the list. Click Scan.

   • If a default scanner is configured for your login session, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.

     You can change the default scanner. For more information, refer to Changing the Default Scanner on page 51.

When scanning starts, a progress bar appears. You cannot perform any other Nolij Web activity while the progress bar is displayed.

Note the following.

• If you are rescanning one page, the selected page in the Document Viewer is replaced with that page. All other pages in the document remain unchanged.

• If you are rescanning more than one page, the first page that you rescan replaces the selected page in the Nolij Web document. Any additional pages are inserted into the document but they do not replace any other pages.

For example, if you select page four of a ten-page document, and you rescan three pages, the first rescanned page replaces page four. The second and third rescanned pages are inserted into the Nolij Web document as pages five and six; they are added as new pages and do not replace any other existing pages. The page total of the document is 12.

Adding Scanned Pages to Documents

Your user role determines if you can add a page to a document. For more information about roles, refer to Understanding Nolij Web User Roles and Privileges on page 27.
You can add a scanned page to a Nolij Web document that is in TIFF format.

1. In the Folder Objects pane, select the document to which you want to add pages.
2. Right-click anywhere in the Document Viewer and select **Scan Append** from the pop-up menu.

   - If you are using web scan without the Java plug-in, after performing the above task described in step 2, in Firefox browser, **Opening launch.jnlp** dialog box appears. By default, **Open with option** is selected. Click **OK**. **Launch.jnlp** file is automatically downloaded and **NolijWeb Scan** dialog box appears which prompts you to select the specific scanner from the list. Click **Scan**.

   - If you are using web scan without the Java plug-in, after performing the above task described in step 2, in Internet Explorer, **Launch.jnlp** file is automatically downloaded and **NolijWeb Scan** dialog box appears which prompts you to select the specific scanner from the list. Click **Scan**.

   - If a default scanner is configured for your login session, the document is scanned immediately by the default scanner. If you do not have a default scanner configured, Nolij Web prompts you to configure one.

   You can change the default scanner. For more information, refer to **Changing the Default Scanner on page 51**.

When scanning starts, a progress bar appears. You cannot perform any other Nolij Web activity while the progress bar is displayed.

After Nolij Web adds the pages, a message appears and displays the number of pages that were added to the document.

**Changing the Default Scanner**

You can change the default scanner that Nolij Web uses to immediately scan documents by doing the following.

1. In the toolbar, click drop-down arrow portion of the **** button.
2. Select **Reset Default Scanner** from the pop-up menu.
   
   The default scanner is no longer set as the default scanner.

3. The next time you press the **** button, Nolij Web prompts you to select the scanner to use as the default scanner.
4. From the drop-down list, select the scanner you want to use as the default scanner.
5. Click **OK** to close the dialog box and apply your changes.

**Creating Document Versions**

When you click a document on which versioning is enabled, the latest version of the document appears in the Document Viewer. If you want to view version information, view or edit other document versions, or revert the document to a previous document version, refer to **Viewing Version Properties on page 57**.

Refer to **Creating Document Versions in Internet Explorer 7 on page 52**.
If versioning is enabled and you have the appropriate permissions, you can manage changes made to documents. You can open such documents in their native editors on your computer, make changes, and save changes to Nolij Web. When you make changes and save documents, new versions are created and saved to Nolij Web.

When you modify a document and create a new version of it, the document is checked out—that is, the document is locked, and no other users can make changes to it. However, if you keep a document checked out and your Nolij Web session expires because of inactivity, the document is no longer checked out.

**Note** Your computer must have an editor defined for the document type you want to edit; Java must also be installed on your computer. You can modify documents in all browsers supported by Nolij Web.

When you click a document on which versioning is enabled, the latest version of the document appears in the Document Viewer. If you want to view version information, view or edit other document versions, or revert the document to a previous document version, refer to Viewing Version Properties on page 57.

### Creating Document Versions in Internet Explorer 7

1. In the Folder Objects pane, right-click the document that you want to edit.
2. Click **Edit Document** from the pop-up menu.
   
   You may receive a dialog box that prompts you to confirm that you want to open the document.
3. To proceed, click **OK**.
   
   The appropriate Microsoft Office or OpenOffice.org program opens and displays the document.
4. Edit the document and then click **Save**.
   
   The Versioning Document dialog box appears.
5. The Next Version displays the number of the next version of the document that will be created. You cannot modify this field.
6. The URL field displays the URL where the document is located. You cannot modify this field.
7. In the comment field, optionally type descriptive information.
8. Click **OK** in the Versioning Document dialog box.
   
   The modified document is saved in Nolij Web.

You can view version properties, view document versions in the Document viewer, edit a version of the document, and discard changes made to a document version. Refer to Viewing Version Properties on page 57.

### Indexing Documents

You can index or assign a document type to a document in the Folder Objects pane. These indexes, configured in Nolij Web according to your specifications, indicate the most commonly used types of documents that your institution manages. For instance, indexes could be W-2, Application, Transcript, or Photograph.

Your user role determines if you can index documents. For more information about roles, refer to Understanding Nolij Web User Roles and Privileges on page 27.

To index a document, complete the following steps.
1. In the Folder Objects pane, right-click the document you want to index. To select multiple documents:
   • Click a document and press and hold the Ctrl key as you click each document.
   • Click a document and press and hold the Shift key as you click another document to select contiguous documents.

2. From the pop-up menu, click the index you want to use.
   The index list contains up to 10 index types, which are either locked or are the most recently used indexes. You can lock indexes to always display them in the index list. If you have permission to index documents to more than 10 index types:
   • If you have not selected any indexes yet, Choose Index Types appears in the pop-up menu.
   • If you have selected an index, More Index Types... appears in the pop-up menu.
   Depending on your Nolij Web configuration, you may be able to index a document as a Global Document or a Shared Document. For information about global documents, refer to Setting Global Documents on page 53. For information about shared documents, refer to Setting Shared Documents on page 54.

3. If you select More Index Types..., the Choose Index Type dialog box appears, which displays the index types you have permission to view and use.

4. To lock an index type, right-click it and select Lock. To unlock a locked index type, right-click it and select Unlock.
   Locked index types appear in the right-click menu for a document in the Folder Objects pane.

5. In the Choose Index Type dialog box, select the index to use.

6. Click OK.
   The document is indexed and the information is refreshed in the Folder Objects pane.
   In addition, the document is renamed to the same name as its index. For example, a filename changes to Application if the index Application has been associated with it. To change the filename of the document, refer to Renaming Documents on page 59.
   You can also index a document by giving it the same name as that of the index. For more information about renaming documents, refer to Renaming Documents on page 59.

Setting Global Documents

If Nolij Web is appropriately configured and you have the necessary privileges, you can set a document as a global document. Global documents are those that are created by a specific department, and all other departments can view them.

To index a document a global document, complete the following steps.

1. In the Folder Objects pane, right-click the document you want to index as a global document. To select multiple documents:
   • Click a document and press and hold the Ctrl key as you click each document.
   • Click a document and press and hold the Shift key as you click another document to select contiguous documents.
2. From the pop-up menu, select the index you want to use.

The document is renamed and indexed and the information is refreshed in the Folder Objects pane. If the index you selected set the document as a global document, the document is labeled in **bold** and all other departments can view it.

In the Folder Objects pane, global documents are labeled in bold red if departments other than your own created the global documents.

*Note* Use caution when setting global documents. After you index a document as a global one, it cannot be indexed to any other index. Also, you can only email, delete, and duplicate them; this information applies to all roles, both those that can create global documents and those who cannot.

### Setting Shared Documents

If Nolij Web is appropriately configured and you have the necessary privileges, you can set a document as a shared document. Shared documents are those created by a specific role and viewable by other particular roles, as specified in your Nolij Web configuration.

To index a document as a shared document, complete the following steps.

1. In the Folder Objects pane, right-click the document you want to set as a shared document. To select multiple documents:
   - Click a document and press and hold the **Ctrl** key as you click each document.
   - Click a document and press and hold the **Shift** key as you click another document to select contiguous documents.

2. From the pop-up menu, select the index you want to use.

   The document is renamed and indexed and the information is refreshed in the Folder Objects pane. If the index you selected set the document as a shared document, any other departments that have permissions to view the shared document can view it.

   In the Folder Objects pane, shared documents are labeled in red if departments other than your own created the shared documents.

   Departments that cannot create shared documents can only delete, email, or duplicate shared documents.

3. From the pop-up menu, check the appropriate option to set the document as a shared document.

### Modifying ImageNow Document Properties in Nolij Web Workflows

If you are working in a Nolij Web workflow and using ImageNow as your document storage repository, you can modify document keys and custom properties for ImageNow documents by right-clicking the document selecting **Document Properties**. You can view and modify document keys and custom properties in the **Form** pane.

For more information, refer to [Modifying ImageNow Document Properties on page 89](#).

### Viewing Nolij Web Document Properties

To view document properties, such as document size and creation date, complete the following steps.
1. In the Folder Objects pane, right-click the document for which you want to view properties.

2. Click Properties from the pop-up menu.

3. Click the Properties tab to view the following information.
   - Name: Name of the document.
   - Created By: User name of the user who created the document.
   - Created On: Date on which the document was created.
   - Modified By: User name of the user who last modified the document.
   - Modified On: Date on which the document was modified.
   - Size: Size, in kilobytes, of the document.
   - Version: If versioning is enabled, the version number of the document.

Viewing and Configuring Nolij Web Custom Document Properties

For information about document properties, refer to Viewing Nolij Web Document Properties on page 54.

Depending on your Nolij Web configuration, you can configure custom document properties for a specific document type. For example, custom document properties can be names of document authors, subject information, and categories. You can associate this information on a document type. This is configured by your Nolij Web administrator.

To apply a custom property to a document type on which custom properties can be configured, complete the following steps.

1. In the Folder Objects pane, right-click the document for which you want to view and configure properties.

2. Click Custom Properties from the pop-up menu.
   
   A dialog box appears in which you can view and configure custom document properties.

3. For property that can be a value selected from a possible list of values, a drop-down box appears from which you can select the property.

4. For property that can be any text you type, a field is provided for the attribute into which you can type the value.

5. Click OK.

6. Click Save.

Viewing OCR Properties

You can view Optical Character Recognition (OCR) information, such as whether OCR was performed on a document and whether words were recognized or excluded.

*Note* A minimum resolution of 200 dpi is required for OCR; 240 dpi is recommended.

When Nolij Web performs an OCR on a document, Nolij Web checks the words in a document against the Nolij Web dictionary. Nolij Web recognizes words that the Nolij Web dictionary contains. If Nolij Web does not recognize a
word, the word is not associated with the document for a keyword search (you cannot use this word to search for the
document), and Nolij Web excludes this word.

You can add excluded words to the Nolij Web dictionary; later, when an OCR is performed, Nolij Web recognizes the
words you added to the dictionary.

1. In the Folder Objects pane, right-click the document for which you want to view properties.
2. Click Properties from the pop-up menu.
   The Document Properties dialog box appears.
3. Click the OCR Stats tab to view the following OCR information:
   - OCR Status: Status of OCR. Values can be:
     - None: No OCR was performed or is pending on the document.
     - Completed: OCR was successfully completed on the document.
     - Pending: OCR is pending for this document.
     - In Queue: OCR is being performed on this document.
     - To Rescan: A change on this document has occurred, and it is scheduled to be rescanned.
     - Error: A problem occurred with the OCR process, and it did not complete.
   - Words Found: Number of words recognized by OCR when the OCR process was most recently performed
     on the document.
   - Words Not Recognized: Number of words that were not recognized by OCR when the OCR process was
     most recently performed on the document. These words appear in the Exception pane.
   - % Words Recognized: Percentage of words in the document that the OCR process recognized when the
     OCR process was most recently performed.

Your Nolij Web administrator configures the percentage of words that OCR must recognize on a document
for OCR to be successful.

The Words Found, Words Not Recognized, and % Words Recognized values reflect the most recent OCR
process for the document. These values also reflect multiple occurrences of each word—if a word appears
more than once in the document, it is counted as two occurrences, not one. However, the OCR process only stores one
occurrence of a word that appears multiple times.

For example, for the text is an asdf sentence an asdf sentence:

   - Seven words are found (is, an, asdf, sentence, an, asdf, and sentence).
   - Five words are recognized (is, an, sentence, an, sentence).
   - Two words are not recognized (asdf and asdf).
   - Five out of seven (78%) of words are recognized.

The OCR process only stores one occurrence of an and sentence, even though they appear twice in the text. Also, the
OCR process only excludes one occurrence of the unrecognized word asdf, even though it appears twice, and asdf
appears only once in the Words Not Recognized pane.
You can fix words, add them to the dictionary, or reject words; however, Words Found, Words Not Found, and % Words Recognized values are not updated. Values are updated only after an OCR is next performed.

You can remove the status message and highlight by clicking the **Remove OCR Status Warning** button. The document icon in the Folder Objects pane is updated.

4. To correct an unrecognized word, complete the following steps.
   1. Select the word in the Unrecognized Words pane and click **Fix**.
      
      The Enter the corrected word dialog box appears.
   2. Type the appropriate word in the dialog box.
   3. Click **OK**.
      
      The word is removed from the Unrecognized Words pane.
      
      The word is corrected, and the corrected word is recognized by OCR for this document only; it is not added to the Nolij Web dictionary, so it is not recognized on subsequent OCR performances. The word is also associated with this document, and you can use it as a keyword to search for the document.

5. To allow an excluded word to be added to OCR for the document, select it in the Unrecognized Words pane and click **Accept**.
   
   The word is removed from the Unrecognized Words pane.
   
   The word is recognized by OCR for this document only; it is not added to the Nolij Web dictionary, so it is not recognized on subsequent OCR performances. The word is also associated with this document, and you can use it as a keyword to search for the document.

6. To add an unrecognized word to the Nolij Web dictionary, select it in the Exception pane and click **Add to Dictionary**.
   
   The word is removed from the Unrecognized Words pane.
   
   The OCR process will recognize this word the next time an OCR is performed, and the word is associated with this document so you can use it as a keyword to search for the document.
   
   Additionally, this word is no longer excluded and is associated with any other document that contains this word (and for which the word is excluded).

7. To reject an excluded word, click it in the Unrecognized Words pane and click **Reject**.
   
   The word is removed from the Unrecognized Words pane and is not associated with the document.

### Viewing Version Properties

If document versioning is enabled, you can view version properties, view a version of the document, edit a version of the document, and discard changes made to a document version.

1. In the Folder Objects pane, right-click the document for which you want to view properties.
2. Click **Properties** from the pop-up menu.
   
   The Document Properties dialog box appears.
3. Click the **Version** tab to view the following information:
   - **User**: Username of the user who last modified the document.
   - **Version**: Version number of the document.
   - **Date**: Date and time on which the document was checked out.
   - **Comments**: Comments, if any, provided by the user who checked out the file or by Nolij Web.
     - For the first version of a document, the Comments column displays Original Version.
     - For documents to which previous document versions were reverted, the Comments column displays Rollback to version x, where x is the document version to which the new document was reverted.

4. To view a version of the document, select the version and click **View**.
   
The version of the document is displayed in the document viewer.
5. To edit a version of the document, select the version and click **Edit**.

When you edit the selected version, you create the latest version of the document. The Versioning Document dialog box appears. Refer to Creating Document Versions on page 51.

6. To revert to the previous version of the document and discard changes made in successive versions, select the document version to which to revert and click **Rollback**.

Changes made to the version of the document are discarded, and the latest version of the document is created. The latest version of the document is updated in the Version tab, and the Comments column displays Rollback to version x, where x is the document version to which the new document was reverted.

### Renaming Documents

You can rename a document or restore the system-generated name.

Note the following:

- The filename must include the name of the index that you want associated with the document. For example, if you want a document indexed as an Application, the filename must include the word Application. If the index name is not included in the filename, the document is not associated with any index.

  For example, a document with the filename College Application is indexed as an Application; a document with the filename College App is not.

- When you restore a document’s system-generated name, the document is no longer associated with any index. If you want a document indexed, you must set the index after resetting the filename. The document becomes a system document type, which are documents that are authored in computer applications and are stored on any computer. Microsoft Office Word, PDF, HTML, and JPEG files are examples of system document types.

- If you type a name for a document that is also a index, the document is then associated with that index. For example, if you name a document Email, and Email is an index that can be assigned to the document, the index of the document becomes an Email.

  For more information about indexing documents, refer to Indexing Documents on page 52.

To rename a document:

1. In the Folder Objects pane, right-click the document you want to rename.

2. Click **Rename** from the pop-up menu.

   The Rename File dialog box appears.

3. Type the new filename and click **OK**.

   The Folder Objects pane refreshes, and the filename is updated.

To restore the system-generated name:

1. In the Folder Objects pane, right-click the document you want to rename. To select multiple documents:

   - Click a document and press and hold the **Ctrl** key as you click each document.
   - Click a document and press and hold the **Shift** key as you click another document to select contiguous documents.
2. In the pop-up menu, click **Reset Name**.  
The Folder Objects pane refreshes, and the filename is restored to the system-generated name.

Deleting Documents

To delete a document:

1. In the Folder Objects pane, right-click the document you want to delete. To select multiple documents:
   - Click a document and press and hold the **Ctrl** key as you click each document.
   - Click a document and press and hold the **Shift** key as you click another document to select contiguous documents.
2. Click **Delete** from the pop-up menu.  
   A dialog box appears, asking you to confirm that you want to delete the document.
3. To delete the document, click **Yes**.  
The document is deleted and is removed from the pane.

Recovering Deleted Documents

To recover deleted documents:

1. Right-click on the folder, which contains the deleted document you want to recover, in the Query Results pane.
2. From the pop-up menu, select **Recover Files in Folder**.  
The Document Recovery dialog box appears.
3. Do one of the following:  
   - To recover one document, select the document you want to recover and click **Recover Document**.
   - To recover all documents, click **Recover All**.
   
   Recovered documents appear in the Folder Objects pane.
Duplicating Documents

You can make a duplicate of a document by doing the following:

1. In the Folder Objects pane, right-click the document you want to duplicate. To select multiple documents:
   - Click a document and press and hold the **Ctrl** key as you click each document.
   - Click a document and press and hold the **Shift** key as you click another document to select contiguous documents.
2. Click **Duplicate** from the pop-up menu.

   The document is copied, and the duplicate document is displayed in the pane. Annotations are also copied and preserved in the duplicate document.

Merging Documents

You can merge multiple documents into one document by doing the following:

1. In the Folder Objects pane, select the documents you want to merge. To select multiple documents:
   - Click a document and press and hold the **Ctrl** key as you click each document.
   - Click a document and press and hold the **Shift** key as you click another document to select contiguous documents.

   The order in which you select documents effects the properties and page order of the merged document. The first document that you select for merging is the document into which other documents are incorporated. The first document is modified and contains any other documents merged into it; all other documents are removed.

   In addition, the merged document has the same properties as the first document you selected, such as name and index type. Pages are added to the merged document according to the order in which the individual documents were selected.

   For example, if you first select the document Transcript, select Application, and finally select Essay to be merged into one document, Transcript is the document into which Application and Essay are merged. In the merged document, pages are ordered by first pages in the Transcript document, then Application, and finally Essay pages.

2. Right-click the documents and select **Merge Selected** from the pop-up menu.

Moving Documents into Query Folders

Your user role determines if you can move documents into a folder. For more information about roles, refer to Understanding Nolij Web User Roles and Privileges on page 27.
You can move documents from one folder to another by doing the following:

1. In the Folder Objects pane, click the documents you want to move. To select multiple documents, click a document and hold the Ctrl key as you select each document.

2. Drag and drop the document into the appropriate folder or subfolder in the Query Results pane.
   
   **Note** In a subindex query, when you add a document to a subindex, the document is automatically associated to the subindex, and its subindex changes accordingly. For more information about subindex queries, refer to **Performing Subindex Queries on page 36**.

The document is moved to the folder.

### Moving Documents into Subfolders

If subfolders are configured, and your privileges allow you to view them, the pane contains a tab for each subfolder. You can move documents to another subfolder by doing the following:

1. In the Folder Objects pane, click the document you want to move. To select multiple documents:
   - Click a document and press and hold the **Ctrl** key as you click each document.
   - Click a document and press and hold the **Shift** key as you click another document to select contiguous documents.

2. Do one of the following:
   - (Recommended): Drag and drop the document to the subfolder tab.
   - Right-click the document and click **Subfolder**. Then, from the pop-up menu, click the subfolder to which you want to move the document.

The document is moved to the subfolder.

### Emailing Documents

If you have the appropriate privileges, you can:

- Send an email with a link to the location from which to download a document with or without annotations.

  **Note** Your Nolij Web administrator may configure that links to documents expire after a certain amount of days after the email was sent, that links expire after a certain amount of hours after the link was first clicked, or that links expire after a certain number of times they are clicked.

- Send a document, with or without annotations, as an attachment in an email message.

  **Note** A copy of the email you send is sent to your email address. If you have privileges to do so, you can change your email address.
Note Depending on your Nolij Web privileges, you either send the document with annotations (if there are any) or without annotations.

1. In the Folder Objects pane, right-click the document you want to email. To select multiple documents:
   - Click a document and press and hold the Ctrl key as you click each document.
   - Click a document and press and hold the Shift key as you click another document to select contiguous documents.

2. Do one of the following:
   - To send an email with a link from which to download the document, select Email Document Download Link from the pop-up menu.
   - To send an email with the documents an attachment, select Email as Attachment from the pop-up menu.
   
   The Email Document dialog box appears.

3. The From field is unavailable; the email is sent from your email address, which is configured by your Nolij Web administrator. If you have permission to do so, you can change your email address by doing the following:
   1. Click the Change Email button
   
   The Change Email dialog box appears.

   2. Type your new email address. Use the format username@domain_name.com, where the username is the email username and domain_name is the domain name of the email address.

   3. Click OK in the Change Email dialog box.

   A confirmation message is sent to the new email address.

   4. You must first confirm the new email address. Open the confirmation email and click the link provided; you must open the link in the browser you are using to run Nolij Web.

   5. Click OK in the Change Email dialog box.

4. In the To field, type the email address of the recipient. Use the format username@domain_name.com, where the username is the email username and domain_name is the domain name of the email address. You can send the email to multiple recipients by separating each email address with a comma (,) or semicolon (;).

5. In the CC field, type the email address of the recipient to which to send a copy of the message. Use the format username@domain_name.com, where the username is the email username and domain_name is the domain name of the email address. You can send the email copy to multiple recipients by separating each email address with a comma (,) or semicolon (;).

6. The Subject field is preconfigured to display the folder name followed by the name of the document or (if you are attaching a or sending a link to a single document) or Multiple Documents (if you are attaching or sending the link to more than one document). You can modify the subject text by typing the appropriate text in the Subject field.

7. Do one of the following:
• Click the **Original** button to send the original document as an attachment; annotations, if any, are not included on the document.

• Click the **Image** radio button to send the current document as an attachment; any annotations, if any, are included on the document.

8. The Message field is preconfigured to display the folder name followed by the name of the document or (if you are attaching a or sending a link to a single document) or Multiple Documents (if you are attaching or sending the link to more than one document). You can change the message text by typing the appropriate text in the Message field.

9. Click **OK** to send the email.

   The email is sent to the recipient

### Searching for Documents in the Folder Objects Pane

You can search for documents, in the Folder Objects pane, that contain specified text, if Nolij Web is configured to perform Optical Character Recognition (OCR) on specified documents, such as TIFF or text documents. When Nolij Web performs OCR, it captures words from documents and stores them in a searchable format. You can use the text in a document to search for the document.

You can also search for documents according to their document index and filter documents based on custom property type.

Your role determines if you can search for text. For more information, refer to Searching All Documents for Specified Text on page 39.

**Note** When you use the search function in the Folder Objects pane, Nolij Web searches for documents in the Folder Objects pane only. To search for all documents in Nolij Web, perform a search as specified in Searching All Documents for Specified Text on page 39.

**Note** When you add a document to a folder, and Nolij Web is configured to perform OCR on the document type, Nolij Web automatically performs OCR on the document; you can then perform a search for the document using text contained in it.

### Filtering Documents by Text

To filter documents by text, do the following.

1. In the Folder Objects pane, click 📑.
2. From the pop-up menu, click **Filter On**.
3. Click **Document Text** to search for documents using key words.
4. In the text field that appears above the Folder Objects pane, type the appropriate text. If you are searching by index type, you can also select the index type from the drop-down box.
5. Press **Enter** to begin the search.
6. Click ▶️ to begin the search.
Nolij Web searches through documents in only the Folder Objects pane for the specified text. Documents that contain the text for which you searched are displayed in the Folder Objects pane.

7. Click \( \times \) to close the search field.

Filtering Documents by Index

To filter documents by index type, do the following.

1. In the Folder Objects pane, click \( \text{Filter On} \).
2. Click Index to search for documents by index type.
3. From the drop-down box that appears above the Folder Objects pane, select the index type by which you want to filter documents. Only documents of that index type are displayed in the table.
4. Click \( \times \) to close the search field.

Filtering Documents by Custom Property

Note You cannot filter documents by custom property if you are using ImageNow as your document storage repository.

To filter documents by custom property, do the following.

1. In the Folder Objects pane, click \( \text{Filter On} \).
2. Click Custom Property, and then select the custom property from the menu.
3. From the drop-down box that appears above the Folder Objects pane, select the custom property by which you want to filter documents. Only documents with the selected custom property are displayed in the table.
4. Click \( \times \) to close the search field.

Adding Template Documents

You can add a document from a preconfigured template. A copy of the document is created from a template and saved to a folder of information.
Do one of the following:

- To add a template document to all folders returned by a query result, right-click the query result in the Query Results pane and select **Add Template Doc**; then, select the template document that you want to add.
  
The template document is added to all folders contained by the query result.

- To add a template document to a folder in the Folder Objects pane, click ; then, select **Add Template Doc**
  and select the template document you want to add.

  The template document is added to the folder.

**Note** Depending on your Nolij Web configuration, some of the information in a template document can be automatically replaced by information taken from the folder. For example, a current date or student name may be taken from a student’s record of information and automatically inserted into the template document.

### Adding and Emailing Template Documents

Depending on your Nolij Web configuration and permissions, when you add a template document you can also send an email with a copy of a template document to the email address specified by your Nolij Web administrator.

1. Do one of the following:
   - To add a template document to all folders returned by a query result and send an email to the specified recipient, right-click the query result in the Query Results pane and select **Add Template Doc**.
   - To add a template document to a folder in the Folder Objects pane and send an email to the specified recipient, click ; then, select **Add Template Doc** and select the template document you want to add.

2. Do one of the following:
   - If you only want to add the template document but do not want to send an email, select **Create**.
   - If you want to create the template document and send an email, select **Create and Email**.

   A dialog box appears from which you can send the email with the template document as an attachment.

3. The From field is unavailable; the email is sent from your email address, which is configured by your Nolij Web administrator. If you have permission to do so, you can change your email address by doing the following:
   1. Click the **Change Email** button

      The Change Email dialog box appears.

   2. Type your new email address. Use the format `username@domain_name.com`, where the username is the email username and domain_name is the domain name of the email address.

   3. Click **OK** in the Change Email dialog box.

      A confirmation message is sent to the new email address.

   4. You must first confirm the new email address. Open the confirmation email and click the link provided; you must open the link in the browser you are using to run Nolij Web.
5. Click **OK** in the Change Email dialog box.

4. The Subject field is preconfigured to display a message stating that the template document is attached. You can modify the subject text by typing the appropriate text in the Subject field.

5. The Message field is preconfigured to display text stating that the specified template document is attached. You can change the message text by typing the appropriate text in the Message field.

6. Click **OK** to send the email.

   The email is sent to the recipient

Automatically Indexing Documents

Depending on your Nolij Web configuration, you can automatically index documents to specific custom document types. You can automatically index documents on which OCR processing has been configured and completed.

**Understanding Automatic Indexing**

Documents on which OCR is configured can be automatically indexed to their associated document types. A document must contain specific OCR keywords, defined by your Nolij Web administrator, so that Nolij Web can automatically index the document type. OCR keywords are unique for each document type.

After Nolij Web finds matches for the OCR keywords, Nolij Web attempts to find specific words in a specified location, defined as an Item of Interest (IOI) on the document. Nolij Web uses the item of interest to automatically index a document to a document type and folder. Nolij Web can search in a fixed location or in a specified zone in a document, depending on your configuration.

Documents can be automatically indexed by one or more of the following methods:

- **Zonal recognition:** Nolij Web searches for an Item of Interest (IOI), which is data that Nolij Web extracts from the document, in a specified zone in the document. Nolij Web can search for the IOI around a specific word (zonal keyword), by searching for a regular expression, or both.

  Your Nolij Web administrator configures all information for zonal recognition. However, if Nolij Web does not recognize an IOI for which zonal recognition is configured, you can set the appropriate word as the IOI in the Nolij Web user interface.

  Multiple IOIs, each configured with a zonal keyword, expression, or both, can be used to index the document.

- **Layout pattern recognition:** Nolij Web searches for an IOI in a document. An identifier (for example, one or more words in a specific location in the document) is used to ensure that the proper template is used.

  Your Nolij Web administrator configures the IOI; administrators or users set a word as the identifier in the Nolij Web user interface. If Nolij Web does not recognize an identifier or IOI, you can set words as identifiers and IOIs in Nolij Web.

  Multiple identifiers and IOIs can be used to index the document.

- **Manual recognition:** If Nolij Web cannot find the appropriate information using either template or recognition and therefore cannot index a document, you can manually provide this information.

  Nolij Web first scans the document for OCR keywords; if it does not contain the OCR keywords, Nolij Web does not further process the document. If it does recognize keywords, Nolij Web attempts layout pattern recognition (if configured); if it does not find matches for identifiers or IOIs, Nolij Web attempts zonal recognition (if configured).
After Nolij Web finds the configured IOIs, it applies a custom name to the document (if configured by your Nolij Web administrator); after it applies a custom name, it moves the document to a specified folder (if configured by your administrator).

When Nolij Web can automatically index a document, the document is indexed to the appropriate document type, and it is displayed as the document type in the Folder Objects pane. You can inspect the document to ensure that it is indexed appropriately and then approve the indexing.

If Nolij Web cannot automatically index a document—for example, it could not locate the IOI on a document—you can manually configure the document so that it can be automatically indexed.

Setting Documents to be Auto-Indexed

**Note** If you move an auto-indexed document into another folder, the document is moved to the new folder. However, it remains displayed in the Folder Objects pane in the previous folder. The document remains displayed in the pane as a reference, and its label changes to blue bold font until you approve the document indexing. Refer to Approving Auto-indexed Documents on page 69.

1. In the Query Results pane, click the appropriate folder.
2. Do one of the following:
   - Select the document you want to automatically index. To select multiple documents:
     - Click a document and press and hold the Ctrl key as you click each document.
     - Click a document and press and hold the Shift key as you click another document to select contiguous documents.
     Then, right-click the document and select **Auto Index**.
   - To automatically index all documents in the folder, in the Folder Objects pane, click . Then, select **Auto Index**.
One of the following occurs:

- If Nolij Web recognized the OCR keywords and IOIs, the document is automatically indexed to the document type. Depending on your Nolij Web configuration, a custom document name may be assigned to the document. Also, depending on your configuration, the document may be moved to a designated folder.

- If Nolij Web did not recognize OCR keywords or IOIs, the document is not indexed.

After Nolij Web completes auto-indexing of documents, a pop-up message is displayed, indicating the number of documents that were successfully auto-indexed.

Approving Auto-indexed Documents

You must approve indexing on an auto-indexed document if you move it to another folder. Do one of the following:

- To approve a document, right-click the document in the folder objects pane and select **Approve Indexing**.

- To approve all documents in the folder, in the Folder Objects pane, click . Then, select **Approve Indexing**.

Defining IOIs

For layout pattern recognition, Nolij Web searches for an identifier on a document. If an identifier is not configured, or if Nolij Web does not recognize the identifier, you set a word as the identifier on the document (refer to Setting Identifiers on page 70).

For zonal recognition, Nolij Web searches for IOIs in relation to a zonal keyword, a regular expression, or both. Zonal recognition is configured by your Nolij Web administrator. If Nolij Web does not recognize an IOI, you can set a word as the IOI on the document.

1. In the Folder Objects pane, right-click the document and select the appropriate document type to which to index the document.
   
The document is indexed to the appropriate document type.

2. Right-click the document and select **Train**.
   
   Words recognized by the OCR process are highlighted in the document in the Document Viewer. Any IOIs recognized by Nolij Web are highlighted in purple.
   
   You can click to show and hide highlighting.

3. To set a word as the IOI that is configured in Nolij Web, right-click the word and select the appropriate identifier from the pop-up menu.
   
   The word is highlighted in purple.

   To clear an IOI, right-click it and select **Clear**.
4. To define a regular expression for the IOI, complete the following steps.
   1. Right-click the keyword identifier and select Regular Expression from the pop-up menu.
      
      The Regular Expression dialog box appears.
   2. Type the expression in the dialog box.
      
      The regular expression you define searches for other information in the document around the area of the
      identifier. Regular expressions are optional; you may want to define a regular expression to ensure that the
      appropriate information is found or if the area containing the IOI is obscured with other information.
      
      You should have programming knowledge to write regular expressions.
   3. Click OK.

5. To save the item, in the toolbar, in the drop-down box, type the name of the item.
   
   You can select any number and combination of identifiers and IOIs and save them as an item in the document;
   you can select the item from the drop-down box and view the identifiers and IOIs configured for the item.

6. Click to save the item.
   
   You can clear an item by selecting it from the drop-down box and clicking in the toolbar.

7. When you are done defining IOIs, click in the toolbar.
   
   For layout pattern recognition, if configured, Nolij Web searches for the identifier. For zonal recognition, if
   configured, Nolij Web searches for the IOI in a specific area of the document; zonal recognition is configured by your
   Nolij Web administrator.

Setting Identifiers

Nolij Web searches for identifiers, which are specified words, to associate a document to a layout pattern. If Nolij
Web finds a match, it searches for IOIs in fixed locations and searches around the IOIs for a value.

To set a word as an identifier, complete the following steps.

1. In the Folder Objects pane, right-click the document and select the appropriate document type to which to index
   the document.
   
   The document is indexed to the appropriate document type.

2. Right-click the document and select Train.
   
   Words recognized by the OCR process are highlighted in the document in the Document Viewer. Any IOIs
   recognized by Nolij Web are highlighted in purple.
   
   You can click to show and hide highlighting.

3. To set a word as an identifier, right-click the word and select Identifier from the pop-up menu.
The identifier is highlighted in blue.
To remove an identifier, right-click the word and select **Remove**.

4. To save the item, in the toolbar, in the drop-down box, type the name of the item. You can select any number and combination of identifiers and IOIs and save them as an item in the document; you can select the item from the drop-down box and view the identifiers and IOIs configured for the item.

5. Click **** to save the item.
You can clear an item by selecting it from the drop-down box and clicking **** in the toolbar.

6. When you are done setting identifiers, click **** in the toolbar.

**Resolving Indexes**

You can resolve an index when OCR is successful on a document but neither template nor zonal recognition found the appropriate information on the document. You can manually provide this information by doing the following:

1. In the Folder Objects pane, right-click the document whose IOI you want to resolve and select **Resolve**. The Index Resolution dialog box appears and displays all IOIs defined on the document.

2. In the field for the IOI, type the appropriate value of the IOI.

3. Click **OK**.

**Importing Emails into the Folder Objects Pane**

Depending on your Nolij Web configuration, you can import email messages and attachments from your email server into Nolij Web folders. You can manually import emails or define rules for email import.

You must have the appropriate permissions to import documents of certain document types. If you try to import an email and do not have the permissions to do so for the document type, Nolij Web places an email in the folder containing the email that cannot be imported. If your Nolij Web administrator later gives you the appropriate permissions, delete the notification email message; Nolij Web automatically verifies that permissions have been provided. If you have the appropriate privileges, emails are imported.
Refer to the following topics for more information:

- Configuring Email Server Settings on page 72.
- Manually Importing Emails on page 73.
- Adding Email Import Rules on page 74.
- Modifying Email Import Rules on page 75.
- Deleting Email Import Rules on page 75.
- Running Manual Import Rules on page 76.

Configuring Email Server Settings

Your Nolij Web administrator may have configured your email server settings; if your settings are not configured, you can configure the email server from which you import emails by doing the following:

1. In the Folder Objects pane, click .
2. Select Email Import.
   
   One of the following occurs.
   - If you have not already configured email settings, the Account Settings dialog box appears.
   - To modify your settings, click the Account Settings button. The Account Settings dialog box appears.
3. In the Server field, type the name of the email server. Use one of the following formats, where servername is the name of the email server, port_number is the port number, and encryption_method is the method used for encryption.

   Note If you do not provide a port number, the default value of 143 is used, and SSL is not used as the encryption method. For SSL encryption, use 993 as the port number.

   • servername:port_number:encryption_method. For example:
     
     mail.myuniversity.edu:993:ssl
   
   • servername:port_number. For example:
     
     mail.myuniversity.edu:993
   
   • servername. For example:
     
     mail.myuniversity.edu

   You cannot use the format servername:encryption_method. For example:

     mail.myuniversity.edu:ssl

4. In the Username field, type the username of the mailbox from which you want to retrieve emails.
5. In the Password field, type the password of the mailbox from which you want to retrieve emails.

6. Click the Test button to test and save your configuration.

   Nolij Web tests your email server configuration; one of the following occurs:
   • If the configuration does not work, a message appears and states that the connection does not work.
   • If the connection is successful, a message appears and states that the connection works, and your settings are saved. Click OK to close the dialog box.

   Your email folders appear in the Email Folders pane. You can manually import emails, or you can create import rules for emails; refer to Manually Importing Emails on page 73 and Adding Email Import Rules on page 74 for more information.

7. Click Save to save your changes.

Manually Importing Emails

To manually import emails into Nolij Web folders, complete the following steps.

1. In the Query Results pane, click the folder into which you want to import an email.

   Note If you do not run a query and select a folder, you cannot manually import emails, and you cannot create import rules. However, any on-demand rules that are configured are run.

2. In the Folder Objects pane, click .

3. Select Email Import.

   The Email Import dialog box appears.

   The Email Folders pane displays the email folders on the server and displays the following information:
   • Name: Name of the email folder.
   • Import Folder: Name of the folder into which you import emails.

4. You create additional email folders on your mail server by doing the following:
   1. Right-click the folder to which you want to add a folder and select Create Folder.

      The Email Import dialog box appears.

   2. Type the name of the folder and click OK.

      The folder is created on your email server; the Email Folders pane refreshes and displays the new folder.

5. In the Email Folders pane, right-click the email folder that contains the email and select View Messages.

   Email messages in the folder are displayed in the Messages pane, which displays the following information:
   • Attn: Name of the person for whom the email is designated.
   • From: Name of the person who sent the email.
   • Received: Date and time on which the email was received.
6. In the Messages pane, right-click the message that you want to import, select **Import**, and select one of the following options:

- **Email**: Imports the email without attachments. Select one of the following:
  - As HTML document: Converts the email to HTML format.
  - As plaintext document: Converts the email to plain text format.

- **Attachment**: Imports an attachment. Select All to import all email attachments, or select the specified email attachment. This option is unavailable if the email contains no attachments.

- **Both**: Imports both the email and attachments. Select one of the following:
  - Email as HTML document: Converts the email to HTML format.
  - Email as plaintext document: Converts the email to plain text format.

If the email import is successful, the Folder Objects pane refreshes and displays the email and attachments as new documents within the query folder.

### Adding Email Import Rules

You can create rules that Nolij Web uses to automatically imports emails into specified folders, or you can create rules that you run manually. You can create one rule per folder. To create email import rules, complete the following steps.

1. In the Query Results pane, click the folder into which you want to import an email.
   
   **Note** If you do not run a query and select a folder, you cannot manually import emails, and you cannot create import rules. However, any on-demand rules that are configured are run.

2. In the Folder Objects pane, click **Email Import**.

3. Select **Email Import**.

   The Email Import dialog box appears.

   The Email Folders pane displays the email folders on the server and displays the following information:
   - **Name**: Name of the folder.
   - **Import Folder**: Name of the folder, selected in the Query Results pane, into which you import emails.

4. In the Email Folders pane, select the email folder for which you want to create a rule and either right-click it and select **Create Rule** or click **Create Rule**.

   A dialog box appears. The Folder field displays the name and folder ID of the selected Nolij Web folder into which you import emails; the Email Folder Path field displays the location of the email folder on your email server from which you import emails. These fields cannot be modified.

5. Check the **Automatic** checkbox if you want Nolij Web to automatically apply the rule.

   If you check this checkbox, after you create and save a rule, the rule is immediately run, and Nolij Web processes any emails in the email folder. Nolij Web runs the rule whenever an email enters the folder.
If you do not check this checkbox, you must run the rule manually. Refer to Running Manual Import Rules on page 76.

6. From the Message Import Type drop-down box, select how you want to import the email message. Options are:
   - HTML: The email is imported in HTML format.
   - PLAINTEXT: The email is imported as plain text.
   - NONE: The email message will not be imported into the folder.

7. Optionally, from the Index message as drop-down box, select the index to associate with the email. These indexes are configured by your Nolij Web administrator.

8. Check the Include Attachments checkbox if you want to import attachments from the email message.

9. From the Index attachments as drop-down box, optionally, select the index to associate with the attachment. These indexes are configured by your Nolij Web administrator.

10. If you checked the Include Attachments checkbox, you can uncheck the Ignore Image Attachments checkbox if you want to import JPEG, GIF, and PNG attachments. These attachments are usually embedded images, such as signature images, and are not external attachments.

11. Click Save to create the rule.

   The Email Folders dialog box refreshes and displays the Nolij Web folder, in the NW Import Folder column, from which emails are imported.

   Automatic rules are run on emails already in the folder and are run again whenever an email enters the folder.

Modifying Email Import Rules

To modify an email import rule, complete the following steps.

1. In the Folder Objects pane, click .

2. Select Email Import.

   The Email Import dialog box appears.

3. In the Email Folders pane, select the email folder for which you want to modify a rule and either right-click it and select Edit Rule or click Edit Rule.

   A dialog box appears and displays information about the rule.

4. Modify the rule, as appropriate. Refer to Adding Email Import Rules on page 74.

Deleting Email Import Rules

To delete a rule, complete the following steps.

1. In the Folder Objects pane, click .

2. Select Email Import.

   The Email Import dialog box appears.
3. In the Email Folders pane, select the email folder for which you want to delete a rule and do one of the following:
   • Either right-click it and select **Delete Rule** or click the Delete Rule button.
     The rule is deleted; the Email Folders pane refreshes, and the Nolij Web import folder is removed from the NW Import Folder column.
   • Either right-click it and select **Edit Rule** or click the Edit Rule button.
     A dialog box appears and displays information about the rule. Then, select **Delete** to delete the rule.

**Running Manual Import Rules**

To run a manual rule, complete the following steps.

1. In the Folder Objects pane, click ![Folder Objects](image).
2. Select **Email Import**.
   The Email Import dialog box appears.
   The Email Folders pane displays the email folders on the server and displays the following information:
   • Name: Name of the email folder.
   • Import Folder: Name of the Nolij Web folder into which you import emails.
3. Do one of the following:
   • To run a rule on a specific folder, in the Email Folders pane, select the email folder that contains the email you want to import and either right-click it and select **Process Rule** or click the Process Rule button.
   • To run all rules, click the Process All button.

After Nolij Web runs the rule, a message appears and indicates whether the rule was successful. The Folder Objects pane refreshes and displays imported emails and attachments as documents in the Nolij Web folder.

If no rules are configured, a message appears and states that no rules are configured for email import.

**Moving Folders in a Nolij Web Workflow**

After you have finished performing your work, you can manually send the folder to the next inbox in the workflow, or Nolij Web can automatically route the documents to the next inbox, depending on your Nolij Web configuration.

When documents are submitted, the entire folder containing all associated documents is sent to the next inbox.

**Moving Folders Manually**

You can override the automatic workflow process for a folder for which you have the appropriate privileges completing one of the following actions.

• Right-clicking a folder in the Query Results pane, selecting **Move to**, and selecting the inbox to which to send the folder.
• Right-clicking the query result in the Query Results pane, selecting **Move to**, and selecting the inbox to which to send all folders in the query result.

• Clicking an inbox in the Workflow area; then, right-clicking the folder from the Inbox Detail dialog box, selecting **Move to**, and selecting the inbox to which to send the folder.

• Clicking a folder in the Query Results pane; then, selecting the inbox drop-down box in the Workflow area, selecting **Move to**, and selecting the inbox to which to send the folder.

The Move To option is unavailable if you do not have permission to move the folder.

**Moving Folders in an Automatic Workflow**

In an automatic workflow, when you click ✅ in the Query Results pane toolbar or when you select **Work Complete** from the folder’s right-click menu in the Query Results pane, the workflow process starts, and Nolij Web routes the folder to the appropriate inbox when the proper conditions are met.

**Note** ✅ is unavailable if a folder is at the end of a workflow and cannot move to another inbox, if you have not selected a folder, or if you do not have privileges to move the folder.

To automatically route the folder:

• Click the folder in the Query Results pane click ✅ in the toolbar.
• Right-click the folder in the Query Results pane and select **Work Complete** from the pop-up menu.
One of the following occurs:

- The Workflow Step dialog box appears if the folder cannot be submitted, and it indicates the reason that the process could not be completed.
  The folder is not routed.
- The Workflow Step Completed dialog box appears if the document was successfully routed.

**Note** You cannot route a folder that is not associated with a workflow. For example, batch folders are typically not associated with a workflow and cannot be routed.

When a folder is moved into an inbox and changes have not yet been viewed when inboxes are expanded, the icon appears next to the inbox.

When inboxes are collapsed and a folder moves into a new inbox, the icon appears next to the inbox to indicate that there are changes that have not been seen to the inboxes in the drop-down box. When you click the inbox drop-down box, the icon appears next to the inbox into which the folder was moved.

You can also remove folders from the workflow, if you have the appropriate privileges. Refer to **Removing Folders from the Workflow on page 78**.

**Removing Folders from the Workflow**

If you have the appropriate privileges, you can remove a folder from your workflow.

- Right-click a folder in the Query Results pane and select **Remove from Workflow** from the pop-up menu.
  The folder is removed from the workflow; however, the folder remains displayed in the Query Results pane.
- Select the inbox in the Workflow area to open the Inbox Detail dialog box; then, right-click a folder in the Inbox Detail dialog box and select **Remove from Workflow** from the pop-up menu.
  The folder is removed from the workflow and is also removed from the Inbox Detail dialog box.

If you remove a folder from the workflow, or if a folder is not in a workflow, when you click a folder in the Query Results pane, **Not in Workflow** appears next to the Current Inbox label.

**Viewing the Graphical Workflow for Nolij Web Workflows**

You can view a graphical representation of the Nolij Web workflow process in the Graphical Workflow dialog box. The workflow defines the path through which folders of information are routed in your institution based upon the criteria defined for your Nolij Web setup.

You can view the graphical workflow only for Nolij Web workflows, not for ImageNow document views, folder views, or workflows.

The following table provides descriptions of the icons in this dialog box.
Table 5: Graphical Workflow Icons and Descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Workflow" /></td>
<td><em>Workflow</em> name.</td>
</tr>
<tr>
<td><img src="image" alt="Inbox" /></td>
<td><em>Inbox</em> to which a folder of information is routed. You can work with documents in a folder when a folder is in an inbox you own.</td>
</tr>
<tr>
<td><img src="image" alt="Complete Step" /></td>
<td><em>Complete Step</em> action, which is associated with an inbox. It represents that work on the folders in the inbox has been completed and that folders can be sent to the next inbox in the workflow.</td>
</tr>
</tbody>
</table>
| ![Condition](image) | *Condition*, which sends a folder to only one of two possible workflow paths (*Yes* or *No*). Frequently, conditions appear in the form of a question. Conditions are configured by your Nolij Web administrator. For example, a condition may be named *Is this a domestic application?* for the following scenario:  
  - Applications with U.S. mailing addresses are sent to an assistant responsible for reviewing domestic applications.  
  - Applications with non-U.S. mailing addresses are sent to a different assistant who is responsible for reviewing non-U.S. applications.  
  Applications with U.S. mailing addresses satisfy *Yes* and move to the appropriate workflow path; applications with non-U.S. mailing addresses satisfy *No* and move to the appropriate workflow path. Refer to Figure 10 on page 80 for an example of the graphical workflow for this scenario. |
| ![Yes](image) | *Yes* condition; when this criteria is met, a folder is routed to this workflow branch. |
| ![No](image) | *No* condition; when this criteria is met, a folder is routed to this workflow branch. |
| ![Rule](image) | *Rule*, which sends a folder to a workflow path, depending on the criteria defined. Rules route folders through one out of two or more workflow paths, while conditions route folders through one of *only two* possible workflow paths. Rules are configured by your Nolij Web administrator. For example, a rule may be named *Route by last name* for the following scenario: Applications are sent to five different assistants to review, and assistants are responsible for reviewing applications based on the first letter of the student’s last name. Folders are routed to the appropriate assistant by the following:  
  - Last names beginning with A through E  
  - Last names beginning with F through J  
  - Last names beginning with K through O  
  - Last names beginning with P through T  
  - Last names beginning with U through Z  
  In this scenario, folders are routed through one of five possible workflow paths. Refer to Figure 11 on page 81 for an example of the graphical workflow for this scenario. |
Figure 10: Condition Example

1. admission
2. application received (121)
3. Complete Step
4. Is this a U.S. application?
   - YES: U.S. applications
   - NO: non-U.S. applications
To view the graphical workflow, select the workflow or view in which you want to work from the Workflow/View area; then, do one of the following.

- From the Workflow/View drop-down box, select the Nolij Web workflow and then click.
- Right-click an inbox Nolij Web Workflow/View area and select **Graphical Workflow** from the pop-up menu. The Graphical Workflow pane appears.
Click an icon and drag and drop it to move it.

You can move the dialog box by clicking on it; when the mouse pointer changes to , press down on your mouse and move the window to the appropriate location.

To resize the dialog box, place your mouse on the edge of the form until the mouse pointer changes to (to resize horizontally), (to resize vertically), or or (to resize both horizontally and vertically).

You can close the dialog box by clicking .

**Note** If you click the Work Complete button to route a folder, and the folder can be routed to the next inbox, the inboxes to and from which the folder is routed are highlighted in the Graphical Workflow dialog box, and the folder moves to the appropriate inbox.
Viewing the Workflow Summary

You can view the number of folders in each of your inboxes associated with the workflows for all your Nolij Web roles by doing the following:

1. Select **Tools > Workflow Summary**.
   The Workflow Status dialog box appears and displays the following information.
   - Role: Name of the role to which you belong.
   - Workflow: Name of the workflow associated with the role.
   - Inbox: The inbox, associated with the workflow, to which you have access.
   - Count: Number of folders in the inbox.
2. Click **OK** to close the dialog box.

Working with ImageNow Workflows

You can use Nolij Web to work with ImageNow workflows. You must have the appropriate permissions in ImageNow to view ImageNow workflows.

You can view ImageNow workflows by selecting the ImageNow workflow from the Workflow/View drop-down box.

The icon next to the menu option name denotes that the option in the Workflow/View drop-down box is an ImageNow workflow.

The Workflow pane for the ImageNow workflow appears below and displays information about the selected ImageNow Workflow.

The name of the view appears in the title caption of the pane. Below the title caption, the ImageNow queues in which you can work appear. The name of the ImageNow workflow appears to the left of the queues.

- **Note** Inboxes can be expanded or collapsed, depending on your preferences. Refer to Collapsing Inboxes and Queues in Drop-Down Boxes on page 26 for more information.

Click a queue to view the items in the workflow queue.

If you are working in an ImageNow workflow that has an associated ImageNow view on which the Related Document feature is enabled (configured in ImageNow by your administrator), when you click a document in the ImageNow workflow, the ImageNow view appears in Nolij Web, if it is not already open; it displays the documents related to the selected document.

Refer to the following topics for more information about what you can do when you work in ImageNow workflows.

- Filtering Documents and Folders in ImageNow Workflows on page 84.
- Opening Folders in ImageNow Workflows on page 87.
- Copying ImageNow Documents on page 87.
- Working with Standalone ImageNow eForms on page 88.
- Working with ImageNow Supplemental eForms on page 88.
Filtering Documents and Folders in ImageNow Workflows

You can filter information displayed in the table by specifying the appropriate filter information in the Filter drop-down boxes and then by clicking the Go button. The pane refreshes and displays the information you chose to filter. Refer to the following table for descriptions of filter options.

You can add additional search fields by clicking the + button. Additional filters appear below the primary filter. Each additional search filter is considered an AND field, and only terms that match the search criteria in all filters are returned. You can remove search fields by clicking the - button.
### Table 1: ImageNow Workflow Filter Options and Descriptions

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Filter Operators</th>
<th>Search Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow item status</td>
<td>is equal to</td>
<td>Select one of the following options.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td>• Any</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Idle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Working</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• On Hold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Pending</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Waiting for sibling</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Waiting for routing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Waiting for inbound Action</td>
</tr>
<tr>
<td>Workflow item type</td>
<td>is equal to</td>
<td>Select one of the following options.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td>• Document</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Folder</td>
</tr>
<tr>
<td>Name</td>
<td>is equal to</td>
<td>Type the value for which to search.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td></td>
</tr>
<tr>
<td>Drawer</td>
<td>is equal to</td>
<td>Type or select the value for which to search.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td></td>
</tr>
<tr>
<td>ImageNow Field 1-5</td>
<td>is equal to</td>
<td>Type the value for which to search.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>The labels for these</td>
<td></td>
</tr>
<tr>
<td></td>
<td>fields are configurable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and are reflected both</td>
<td></td>
</tr>
<tr>
<td></td>
<td>in the filter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>drop-down box and the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>table columns.</td>
<td></td>
</tr>
<tr>
<td>Filter Option</td>
<td>Filter Operators</td>
<td>Search Field</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Document Type</td>
<td>is equal to&lt;br&gt;is not equal to&lt;br&gt;is less than&lt;br&gt;is greater than&lt;br&gt;is less than or equal to&lt;br&gt;is greater than or equal to&lt;br&gt;starts with</td>
<td>Type or select the value for which to search.</td>
</tr>
<tr>
<td>Folder type</td>
<td>is equal to&lt;br&gt;is not equal to&lt;br&gt;is less than&lt;br&gt;is greater than&lt;br&gt;is less than or equal to&lt;br&gt;is greater than or equal to&lt;br&gt;starts with</td>
<td>Type or select the value for which to search.</td>
</tr>
<tr>
<td>Folder status</td>
<td>is equal to&lt;br&gt;is not equal to</td>
<td>Select the folder status from the drop-down box. Options are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Active&lt;br&gt;• Inactive</td>
</tr>
<tr>
<td>Any Document Key</td>
<td>is equal to&lt;br&gt;is not equal to&lt;br&gt;is less than&lt;br&gt;is greater than&lt;br&gt;is less than or equal to&lt;br&gt;is greater than or equal to&lt;br&gt;starts with</td>
<td>Type the value for which to search. Document keys can be the value of one of the following.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Drawer&lt;br&gt;• Name&lt;br&gt;• Field x&lt;br&gt;• Document type</td>
</tr>
<tr>
<td>Custom Property...</td>
<td>The operators available depend on the custom property you select.</td>
<td>When you select a custom property filter, the Custom Properties dialog box appears. Select a property for which to search and click OK. Next, specify the filter information, which depends on the custom property you selected, The custom property also appears as a filter option in the filter drop-down box for the duration of your Nolij Web session, and you can use this filter option for subsequent filters.</td>
</tr>
</tbody>
</table>
Opening Folders in ImageNow Workflows

To open a folder, right-click it and select **Open Folder**. The Folder dialog box appears and displays the items in the folder, which can be one of the following items.

- Document
- Document shortcut
- Folder

In the Folder dialog box, you can do the following.

- View a document in the Document Viewer by selecting the document or document shortcut.
- Open a folder by right-clicking the folder and selecting **Open Folder**. You can display multiple Folder dialog boxes, close Folder dialog boxes, and reposition them.
- View document keys by right-clicking a document or document shortcut and selecting **Document Properties**.
- Configure custom properties by right-clicking a document or document shortcut and selecting **Document Properties**. For more information about configuring custom properties, refer to Modifying ImageNow Document Properties on page 89.
- View a document in a new window by right-clicking a document or document shortcut and selecting **View in New Window**. For more information, refer to Opening Documents in New Windows on page 88.

Copying ImageNow Documents

To copy an ImageNow document, complete the following steps.

1. Right-click the document you want to copy and select **Copy Document**.
   
   The Copy Document dialog box appears and displays the document keys configured on the document.

2. Modify the appropriate fields.

3. Click **OK**.
   
   If you are using content modeling, a new document is created with the prefix Copy of added to the document name. If there is already a document with that name, a number is added to the prefix to make the name unique. If you are not using content modeling, you must change at least one of the document key fields before clicking **OK**.
Working with Standalone ImageNow eForms

An ImageNow document can be configured as a form. When you select documents of this type in ImageNow document views, folder views, and workflows, the form and its associated data is displayed in the ImageNow Form pane in the top rightmost pane. If a form has multiple forms, a drop-down box appears in the ImageNow Form pane, and you can select the form you want to view from the drop-down box.

If the standalone eForm has attached documents, you can view documents by clicking in the toolbar of the ImageNow Form pane. The Document Viewer is displayed, and you can return to the ImageNow Form pane by clicking .

You can print the eForm by clicking .

You can modify eForms and save your changes by clicking .

Working with ImageNow Supplemental eForms

If you have permission to view ImageNow supplemental eForms, when you click a document in an ImageNow document view, workflow or task view, the drop-down box in the Form pane contains the available supplemental eForms, and the Form pane displays the default supplemental eForm. Additionally, the Form pane allows you to select Nolij Web forms if you have permission to view Nolij Web forms.

However, if you select a document that is a standalone eForm, the Document Viewer pane displays the eForm, and supplemental eForms do not apply.

You can print supplemental eForms by clicking in the Form pane.

You can modify eForms and save your changes by clicking .

Opening Documents in New Windows

You can open multiple documents in new windows (for example, for side-by-side comparison) in ImageNow workflows, document views, or folder views. Complete one of the following actions.

- In the ImageNow document view or workflow, right-click the document and select View in New Window.
- In the ImageNow folder view, right-click the folder and select Open Folder; then, in the dialog box that displays the documents in the folder, right-click the document and select View in New Window.

The document displays in a standalone Document Viewer in a new window in view-only mode.

Opening Documents in Associated Applications

You can open documents in ImageNow workflows and document views in the application designated to open the particular file type. For example, a PDF file opens in Adobe Acrobat if Acrobat is specified as the application that opens PDF files.
Right-click the document you want to open and select **View in Associated Application**. The associated application opens and displays the document. If the document contains more than one page, a dialog box appears, and you can select the page you want to open in the application.

**Modifying ImageNow Document Properties**

To view ImageNow document keys and custom properties, complete one of the following actions.

- In ImageNow document views or workflows, right-click the document you want to modify and select **Document Properties**.
- In ImageNow folder views, right-click the folder and select **Open Folder**; then, in the dialog box that appears, right-click the document and select **Document Properties**.

To modify document keys, complete the following steps.

1. In the **Document Keys** area in the **Form** pane, from the **Drawer** list, select the ImageNow drawer into which to place the document.

   The **Name** field displays the document name and cannot be modified.

   The following five fields are ImageNow fields that display associated information about the document. This document information is metadata that can be used to search for the document (for example, if you type Application for Field 2, you can search for any document that has a value of Application for Field 2).

2. Type the value for each field in the corresponding field.

   **Note** Your ImageNow configuration determines how the fields are labeled. If labels do not appear for fields, the fields are named, by default, the field number as configured in ImageNow.

3. From the **Type** list, select the ImageNow document type for the document.

To modify ImageNow custom properties, complete the following substeps.

1. In the **Form** pane, click **** to expand the **Custom Properties** pane.

2. For a property that can be a value selected from a possible list of values, a list appears from which you can select the property.

3. For a property that can be any text you type, a field is provided for the attribute into which you can type the value.

4. For a property for which you can select a date, click **** to open a calendar from which you can select the appropriate date.

5. For a property for which you can select a **True** or **False** option, select the corresponding option.

6. For a property for which you can select a user, select the appropriate user from the drop-down box.

7. For composite properties, which consist of multiple properties that you can apply to the document, you can add, modify, or delete properties. Complete one of the following actions.

   - To add a composite property, click **Add** to open the **Custom Property Editor** dialog box, and then specify the appropriate information in the fields provided. Click **OK** to close the dialog box.
To modify a property, select the property and click **Edit** to open the **Custom Property Editor** dialog box. Specify the appropriate information and click **OK** to save your changes.

To delete a property, select the property and click **Delete**.

8. Click the **Save** button.

The document view, folder view, or workflow refreshes and displays the saved changes. If the document view, folder view, or workflow was filtered, the pane may not display the modified document (for example, if you filtered on a drawer and then changed the drawer, the document is removed when the document view, folder view, or workflow is refreshed).

**Deleting Items from ImageNow Workflows**

To permanently delete an item from an ImageNow workflow, right-click the item you want to delete and select **Delete**.

**Removing Items from ImageNow Workflows**

Removing an item from an ImageNow workflow does not permanently delete it. Refer to **Deleting Items from ImageNow Workflows** on page 90 for information on how to permanently delete an item from a workflow.

To remove an item from an ImageNow workflow, in the Workflow pane, right-click the item you want to remove from the workflow and select **Remove from workflow**. The item is removed from the workflow and is no longer displayed in the Workflow pane.

**Setting Item Status**

To set the status of an item in the ImageNow workflow, in the workflow pane, right-click the item for which you want to configure status and select the appropriate status from the pop-up menu.

- Mark Item as Idle
- Mark Item as On Hold
- Mark Item as Pending

**Routing Items in ImageNow Workflows**

To route an item in the ImageNow workflow, in the workflow pane, right-click the item you want to move and select **Route Anywhere** to move the item to a queue that you select. If you can route the item to multiple queues, the queues appear as menu options in the pop-up menu. You can also route documents to a selected queue by dragging and dropping the document to the appropriate queue.

**Emailing ImageNow Documents**

You can email ImageNow documents as attachments in Nolij Web 6.8.4 or higher. You can email documents as links in Nolij Web 6.8.4 or higher. To email an ImageNow document, complete the following steps.
1. Right-click a document and select **Email**.

2. The **From** field is unavailable; the email is sent from your email address, which is configured by your Nolij Web administrator. If you have permission to do so, you can change your email address by completing the following substeps.
   1. Click the **Change Email** button
   2. Enter your new email address. Use the format `username@domain_name.com`, where the username is the email user name and domain_name is the domain name of the email address.
   3. Click **OK**. A confirmation message is sent to the new email address.
   4. You must first confirm the new email address. Open the confirmation email and click the link provided; you must open the link in the browser you are using to run Nolij Web.
   5. Click **OK**.

3. In the **To** field, type the email address of the recipient. Use the format `username@domain_name.com`, where the username is the email username and domain_name is the domain name of the email address. You can send the email to multiple recipients by separating each email address with a comma (,) or semicolon (;).

4. In the **CC** field, type the email address of the recipient to which to send a copy of the message. Use the format `username@domain_name.com`, where the username is the email username and domain_name is the domain name of the email address. You can send the email copy to multiple recipients by separating each email address with a comma (,) or semicolon (;).

5. The **Subject** field is preconfigured to display the folder name followed by the name of the document. You can modify the subject text by typing the appropriate text in the **Subject** field.

6. In the **Method** field, select one of the following options.
   - **Attachment**: Select this option to send the document as an attachment.
   - **Link requiring authentication**: Select this option to send a link to the document that requires authentication.

7. The **Message** field is preconfigured to display the folder name followed by the name of the document. You can change the message text by typing the appropriate text in the **Message** field.

8. Click **OK**.

### Working with ImageNow Document Views

Your administrator can configure Nolij Web to allow you to work with ImageNow document views. You must have the appropriate permissions in ImageNow to work with ImageNow document views.

In Nolij Web, the ImageNow document view contains only the documents with which you need to work. You can open ImageNow document views by selecting the document view from the Workflow/View drop-down box.

The [ ] that appears next to the menu option name in the Workflow/View drop-down box denotes that the option is an ImageNow document view. The name of the view appears in the title caption of the pane.
Refer to the following topics for more information about the tasks you can perform with ImageNow document views.

- Copying ImageNow Documents on page 87.
- Working with Standalone ImageNow eForms on page 88.
- Working with ImageNow Supplemental eForms on page 88.
- Opening Documents in New Windows on page 88.
- Opening Documents in Associated Applications on page 88.
- Modifying ImageNow Document Properties on page 89.
- Emailing ImageNow Documents on page 90.
- Filtering Documents in ImageNow Document Views and Folders in Folder Views on page 92.
- Adding ImageNow Files to ImageNow Workflows on page 94.
- Deleting ImageNow Files from ImageNow Document Views on page 95.

Filtering Documents in ImageNow Document Views and Folders in Folder Views

You can filter information displayed in the table by specifying the appropriate filter information in the Filter drop-down boxes and then by clicking the Go button. The pane refreshes and displays the information you chose to filter.

Refer to the following table for descriptions of filter elements.

You can add additional search fields by clicking the + button. Additional filters appear below the primary filter. Each additional search filter is considered an AND field, and only terms that match the search criteria in all filters are returned. You can remove search fields by clicking the - button.
Table 2: ImageNow Document View and Folder View Filter Options and Descriptions

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Filter Operators</th>
<th>Search Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>is equal to</td>
<td>Type the value for which to search.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or</td>
<td></td>
</tr>
<tr>
<td></td>
<td>equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td></td>
</tr>
<tr>
<td>Drawer</td>
<td>is equal to</td>
<td>Type or select the value for which to search.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or</td>
<td></td>
</tr>
<tr>
<td></td>
<td>equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td></td>
</tr>
<tr>
<td>ImageNow Field 1 - 5</td>
<td>is equal to</td>
<td>Type the value for which to search.</td>
</tr>
<tr>
<td>Note The labels for these</td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td>fields are configurable and</td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td>are reflected both in the</td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td>filter drop-down box and</td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td>the table columns</td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td></td>
</tr>
</tbody>
</table>
Adding ImageNow Files to ImageNow Workflows

You can add files from ImageNow document views to ImageNow workflows by doing the following.

1. Select the ImageNow view from which you want to add files from the Workflow/View drop-down box.
2. Select the ImageNow workflow to which you want to add files from the Workflow/View drop-down box.
3. Perform one of the following actions.
   - Select the queue to which you want to add the file in the Workflow pane. Next, select the file from the View pane, click it, and drag and drop it into the table in the Workflow pane.
     The Workflow pane refreshes and displays the file you added.
   - Select the file you want to add in the View pane and then drag and drop it into the appropriate ImageNow queue in the Workflow pane.
     If you are viewing the queue into which you added the file, the Workflow pane refreshes and displays the file you added. Otherwise, to view the file you added, select the queue to which you added the file.
   - Right-click a file in the View pane, select Add to workflow, and then select the Workflow and workflow queue to which you want to add the file.

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Filter Operators</th>
<th>Search Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>is equal to</td>
<td>Type or select the value for the document type for which to search.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td></td>
</tr>
<tr>
<td>Any Document Key</td>
<td>is equal to</td>
<td>Type the value for which to search. Document keys can be the value of one of the following.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td></td>
</tr>
</tbody>
</table>
| Custom Property...  | The operators available depend on the custom property you select. | When you select a custom property filter, the Custom Properties dialog box appears. Select a property for which to search and click OK. Next, specify the filter information, which depends on the custom property you selected,
|                     |                                                       | The custom property also appears as a filter option in the filter drop-down box for the duration of your Nolij Web session, and you can use this filter option for subsequent filters. |
The Workflow pane does not automatically refresh. To refresh the information in the pane and display documents you added, click the Go button in the Workflow pane.

Files that you add from ImageNow views are not removed from ImageNow views and therefore remain displayed in the View pane.

Deleting ImageNow Files from ImageNow Document Views

To delete a file from ImageNow document views, in the Document View pane, right-click the file you want to delete and click Delete. The file is deleted and is removed from the Document View pane.

Working with ImageNow Folder Views

Your administrator can configure Nolij Web to allow you to work with ImageNow folder views. You must have the appropriate permissions in ImageNow to work with ImageNow folder views.

In Nolij Web, the ImageNow folder view contains only the folders with which you need to work. You can open ImageNow folder views by selecting the document view from the Workflow/View drop-down box.

The that appears next to the menu option name in the Workflow/View drop-down box denotes that the option is an ImageNow folder view. The name of the folder view appears in the title caption of the pane. Refer to the following topics for more information about the tasks you can perform with ImageNow folder.

- Working with ImageNow Supplemental eForms on page 88.
- Opening Documents in New Windows on page 88.
- Modifying ImageNow Document Properties on page 89.
- Emailing ImageNow Documents on page 90.
- Filtering Documents in ImageNow Document Views and Folders in Folder Views on page 92.
- Adding Folders to ImageNow Workflows on page 95.
- Opening Folders in Folder Views on page 95.
- Deleting Folders from ImageNow Folder Views on page 96.

Adding Folders to ImageNow Workflows

To add a folder in an ImageNow folder view to an ImageNow workflow, right-click the ImageNow folder in the Folder View pane and select Add to Workflow. Next, select the ImageNow workflow and queue to which to add the folder.

This option is unavailable if the folder is already in an ImageNow workflow.

Opening Folders in Folder Views

If there are folders in the ImageNow folder view, right-click the folder and select Open Folder. In the resulting dialog box that displays the documents in the folder, right-click the folder and select Open Folder.
Deleting Folders from ImageNow Folder Views

To delete a folder from an ImageNow folder view, right-click the folder and select **Delete**.

Working with ImageNow Task Views

Your administrator can configure Nolij Web to allow you to work with ImageNow task views. You must have the appropriate permissions in ImageNow to work with ImageNow document views.

In Nolij Web, the ImageNow task view contains only the tasks with which you need to work. You can open ImageNow task views by selecting the task view from the **Workflow/View** drop-down box. If you select a task associated with a document, the document displays in the **Document Viewer**.

The icon that appears next to the menu option name in the **Workflow/View** drop-down box denotes that the option is an ImageNow task view. The name of the task view appears in the title caption of the pane.

Refer to the following topics for more information.

- Working with ImageNow Supplemental eForms on page 88.
- Emailing ImageNow Documents on page 90.
- Filtering Tasks in ImageNow Task Views on page 96.
- Opening Tasks on page 98.

Filtering Tasks in ImageNow Task Views

You can filter information displayed in the table by specifying the appropriate filter information in the **Filter** drop-down boxes and then clicking the **Go** button. The pane refreshes and displays the information you chose to filter. Refer to the following table for descriptions of filter elements.

You can add additional search fields by clicking the + button. Additional filters appear below the primary filter. Each additional search filter is considered an AND field, and only terms that match the search criteria in all filters are returned. You can remove search fields by clicking the - button.
<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Filter Operators</th>
<th>Search Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task type</td>
<td>is equal to</td>
<td>Select the value for which to search. Options are:</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td>• Approval</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Document deficiency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Pointer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Signature Required</td>
</tr>
<tr>
<td>Assignment Date</td>
<td>is equal to</td>
<td>Type or select a date from the calendar.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td>Assigned by</td>
<td>is equal to</td>
<td>Type the value for which to search.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td></td>
</tr>
<tr>
<td>Assigned to</td>
<td>is equal to</td>
<td>Type the value for which to search.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>starts with</td>
<td></td>
</tr>
<tr>
<td>Due date</td>
<td>is equal to</td>
<td>Type or select a date from the calendar.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td>Days until due</td>
<td>is equal to</td>
<td>Type the value for which to search.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
</tbody>
</table>
Table 3: ImageNow Task View Filter Options and Descriptions (Continued)

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Filter Operators</th>
<th>Search Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date</td>
<td>is equal to</td>
<td>Type or select a date from the calendar.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td>Completion date</td>
<td>is equal to</td>
<td>Type or select a date from the calendar.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
<tr>
<td>Task Status</td>
<td>is equal to</td>
<td>Select the value for which to search. Options are:</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td>• Assigned</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Returned</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Complete pending review</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Complete</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Canceled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Invalid</td>
</tr>
<tr>
<td>Obsolete date</td>
<td>is equal to</td>
<td>Type or select a date from the calendar.</td>
</tr>
<tr>
<td></td>
<td>is not equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than or equal to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is greater than or equal to</td>
<td></td>
</tr>
</tbody>
</table>
3. To return a task, complete the following substeps.
   1. Click the **Return** button.
   2. From the **Reason** list, select the reason you are returning the task.
   3. In the **Comments** box, optionally enter comments about the task you are returning.
   4. Click **OK**.

4. To complete a task that is assigned to you, complete the following substeps.
   1. Click the **Complete** button.
   2. From the **Reason** list, select the reason you are completing the task.
   3. In the **Comments** box, optionally enter comments about the task you are completing.
   4. Click **OK**.

5. To sign a task that is assigned to you and requires a signature, complete the following substeps.
   1. From the **Reason** list, select the reason you are completing the task.
   1. Click the **Sign** button.
   2. In the **Digital Signature Authentication** dialog box, enter your digital signature password.
   3. Click **OK**.

**Working with Documents in the Document Viewer**

In the Document Viewer, you can view documents for Nolij Web workflows, ImageNow views, or ImageNow workflows. To display documents in the Document Viewer, complete one of the following options.

- To view documents in Nolij Web workflows, select the Nolij Web workflow from the Workflow/View drop-down box. Find the document you want to view and then click it to display it in the Folder Objects pane.
- To view documents in ImageNow workflows, select the ImageNow workflow from the Workflow/View drop-down box. Click the ImageNow queue that contains the document you want to open, and then double-click the document in the Workflow pane.
- To view documents in ImageNow views, select the ImageNow view from the Workflow/View drop-down box. In the View pane, double-click the document to display it in the Document Viewer.

**Note** If you open a document in an application other than Nolij Web, any document annotations that you created are no longer visible.

If a document is too large to fully display in the Document Viewer, you can use the scrollbars to navigate to portions of the document that do not display. If you use a mouse with a mouse wheel, you can vertically scroll through a document.
When a multipage document is open, options for multipage navigation appear. These allow you to navigate to
different pages in a document. The bookmark elements also appear for documents in Nolij Web workflows.

Figure 13: Multipage Navigation Elements

In addition, if you have a mouse with a mouse wheel, you can use it to navigate to the next or previous page. When
you are at the top of a document page and scroll up on the mouse wheel, you navigate to the previous page; when you
are at the bottom of a page and scroll down, you navigate to the next page.

Figure 14: Bookmark Elements

For documents in Nolij Web workflows, you can add bookmarks to pages in multipage documents, which you can use
to navigate to a specific page.

To add a bookmark to a page, complete the following steps

1. In the Document Viewer, navigate to the page you want to bookmark.
2. In the bookmark field in the toolbar, type the text you want to use for the bookmark.
3. Click .

The page is bookmarked. You can navigate to a bookmarked page by selecting the appropriate bookmark from
the bookmark list or clicking the or buttons.

To delete a bookmark, select it and click .

The following topics provide more information about the Document Viewer:

- Supported File Types on page 101.
- Printing Documents on page 104.
- Moving Documents in Drag Mode on page 104.
- Rotating Documents on page 105.
- Zooming in and Out on page 105.
- Resizing Documents in the Document Viewer on page 105.
- Resizing the Document Viewer on page 105.
- Extracting Pages from Documents on page 106.
- Showing and Hiding Annotations on page 106.
- Using Nolij Web Annotations on page 106.
- Using ImageNow Annotations on page 110.
• Resizing Annotations and Redactions on page 117.
• Moving Annotations and Redactions on page 117.
• Deleting Annotations and Redactions on page 118.
• Rotating Documents on page 105.

Supported File Types

Nolij Web supports the following file types.

**Word Processor Formats**

- ODF Text Document (*.odt)
- ODF Text Document Template (*.ott)
- OpenOffice.org 1.0 Text Document (*.swx)
- OpenOffice.org 1.0 Text Document Template (*.swx)
- Microsoft Word 97, 2000, XP (*.doc)
- Microsoft Word 97, 2000, XP Template (*.dot)
- Microsoft Word 6.0, 95 (*.doc)
- Microsoft Word 95 Template (*.dot)
- Rich Text Format (*.rtf)
- StarWriter 3.0 to 5.0 (*.sdw)
- StarWriter 3.0 to 5.0 Templates (*.vor)
- Text (*.txt)
- Text Encoded (*.txt)
- HTML Document (*.html; *.htm)
- AportisDoc (Palm) (*.pdb)
- DocBook (*.xml)
- Microsoft WinWord 5 (*.doc)
- Microsoft Word 2003 XML (*.xml)
- Microsoft Word 2007 XML (*.docx; *.docm)
- Microsoft Word 2007 XML Template (*.dotx; *.dotm)
- Pocket Word (*.psw)
- StarWriter 1.0 (*.sdw)
- StarWriter 2.0 (*.sdw)
- StarWriter DOS (*.txt)
- T602 Document (*.602; *.txt)
- Unified Office Format Text (*.uot; *.uof)
- Corel WordPerfect Document (*.wpd)
- Hangul WP 97 (*.hwp)

**Spreadsheets**

- ODF Spreadsheet (*.ods)
- ODF Spreadsheet Template (*.ots)
- OpenOffice.org 1.0 Spreadsheet (*.sxc)
- OpenOffice.org 1.0 Spreadsheet Template (*.stc)
- Data Interchange Format (*.dif)
- dBASE (*.dbf)
- Microsoft Excel 97, 2000, XP (*.xls; *.xlc; *.xlm; *.xlw)
- Microsoft Excel 97, 2000, XP Template (*.xlt)
- Microsoft Excel 4.x to 5.0, 95 (*.xls; *xlc; *.xlm; *.xlw)
- Microsoft Excel 4.x to 5.0, 95 Templates (*.xlt)
- Rich Text Format (OpenOffice.org Calc) (*.rtf)
- StarCalc 3.0 to 5.0 (*.sdc)
- StarCalc 3.0 to 5.0 Templates (*.vor)
- StarCalc 1.0 (*.sdc)
- SYLK (*.slk)
- Text CSV (*.csv; *.txt; *.xls)
- Microsoft Excel 2007 Binary (*.xlsb)
- Microsoft Excel 2007 XML (*.xslm; *.xlsx)
- Microsoft Excel 2007 XML Template (*.xltxm, *.xltx)
- IBM Lotus 1-2-3 (*.wk1; *.wks; *.123)
- Microsoft Excel 2003 XML (*.xml)
- Pocket XML (*.pxl)
- Unified Office Format spreadsheet (*.uos; *.uof)

**Presentation Formats**

- ODF Presentation (*.odp)
- ODF Presentation Template (*.otp)
- OpenOffice.org 1.0 Presentation (*.sxi)
* OpenOffice.org 1.0 Presentation Template (*.sti)
* Microsoft PowerPoint 97, 200, XP (*.ppt; *.pps)
* Microsoft PowerPoint 97, 2000, XP Template (*.pot)
* OpenOffice.org 1.0 Drawing (OpenOffice.org Impress) (.sxd)
* StarDraw 3.0, 5.0 (StarImpress) (*.sda; *.sdd)
* StarImpress 4.0, 5.0 (*.sdd; *.sdp)
* StarImpress 4.0, 5.0 (*.vor)
* CGM - Computer Graphics Metafile (*.cgm)
* Microsoft PowerPoint 2007 XML (*.pptm; *.pptx)
* Microsoft PowerPoint 2007 XML Template (*.potm; *.potx)
* Unified Office Format Presentation (*.uop; *.uof)
* ODF Drawing (Impress) (*.odg)

**Drawing/Image Formats**

* ODF Drawing (*.odg)
* ODF Drawing Template (*.otg)
* OpenOffice.org 1.0 Drawing (*.sxd)
* OpenOffice.org 1.0 Drawing Template (*.std)
* StarDraw 3.0, 5.0 Templates (*.vor)
* PDF - Portable Document Format (*.pdf)
* SVM - StarView Metafile (*.svm)
* WMF - Windows Metafile (*.wmf)
* BMP - Windows Bitmap (*.bmp)
* GIF - Graphics Interchange Format (*.gif)
* JPEG - Joint Photographic Experts Group (*.jpg; *.jpeg; *.jif; *.jif; *.jpe)
* PBM - Portable Bitmap (*.pnm)
* PCX - Zsoft Paintbrush (*.pcx)
* PGM - Portable Greymap (*.pgm)
* PNG - Portable Network Graphic (*.png)
* PPM - Portable Pixelmap (*.ppm)
* PSD - Adobe Photoshop (*.psd)
* RAS - Sun Raster Image (*.ras)
* TGA - Truevision Targa (*.tga)
• TIFF - Tagged Image File Format (*.tif; *.tiff)
• XBM - X Bitmap (*.xbm)
• XPM - X PixMap (*.xpm)
• PCD - Kodak Photo CD (768x512)(*.pcd)
• PCD - Kodak Photo CD (192x128)(*.pcd)
• PCD - Kodak Photo CD (384x256)(*.pcd)

Mail Messages ¶
• MSG Microsoft Exchange Message Format (*.msg)
• TXT Encoded text mail message (*.eml; *.txt)

Web Pages ¶
• MHT Microsoft Archived Web Format (*.mht)
• HTML - Hypertext Markup Language (*.html; *.hml)

Mathematical Notation ¶
• ODF Formula (*.odf)
• OpenOffice.org 1.0 Formula (*.sxm)
• StarMath 2.0 to 5.0 (*.smf)
• MathML 1.01 (*.mml)

Printing Documents

To print a document, complete the following steps.

1. In the Document Viewer toolbar, click .
   The Print dialog box for the browser appears.
2. Set the appropriate print settings and print the document.
   Any document annotations are printed.

Moving Documents in Drag Mode

The Document Viewer displays documents in sections. You can select to choose Drag Mode to move the document sections; when you hover your mouse over the document, the pointer changes to . Then, when you click a document to select it, you can move the document in any direction to view the desired portion of the document.
Rotating Documents

To rotate a document, complete one of the following options.

- To rotate a document counterclockwise, click 🔄 in the Document Viewer toolbar.
- To rotate a document clockwise, click 🔄 in the Document Viewer toolbar.

Any annotations are also rotated.

Zooming in and Out

To magnify (zoom in) the size of a document, complete one of the following options.

- Click 🕐 in the Document Viewer toolbar.
- Right-click anywhere in the Document Viewer and select Zoom In from the pop-up menu.

To reduce (zoom out) the size of a document, complete one of the following actions:

- Click 🕐 in the Document Viewer toolbar.
- Right-click anywhere in the Document Viewer and select Zoom Out from the pop-up menu.

You cannot zoom out of a document that fits the entire area of the Document Viewer.

Resizing Documents in the Document Viewer

To resize a document to fit the width of the Document Viewer, complete one of the following actions.

- Click 📸 in the Document Viewer toolbar.
- Right-click anywhere in the Document Viewer and select Fit Width from the pop-up menu.

To resize a document to fit in the entire area of the Document Viewer, complete one of the following actions.

- Click 📸 in the Document Viewer toolbar.
- Right-click anywhere in the Document Viewer and select Fit Page from the pop-up menu.

You cannot zoom out of a document that fits in the entire area of the Document Viewer.

Resizing the Document Viewer

To resize the Document Viewer to fit into the entire width of the browser window, click 📸 in the Document Viewer toolbar. All other panes, excluding the main toolbar and the Form pane (if it is configured), are collapsed to the left of the Document Viewer. To restore the Document Viewer to its original size and to restore the excluded panes, click 📸.
Extracting Pages from Documents

You can extract pages from documents in Nolij Web workflows only.

To extract a page or all pages from a document, complete the following steps.

1. In the Document Viewer, navigate to the page of the document that you want to extract.

2. In the Document Viewer toolbar, click .

3. Complete one of the following options.
   - To extract the page you are currently viewing, select Extract Current Page. You are then prompted to delete the extracted page from the document.
     If you want to delete the extracted page, click Yes.
     The page is extracted from the document, and it appears in the Folder Objects pane, which refreshes to display the extracted page as a new document.
   - To extract all pages, select Extract All Pages. You are then prompted to confirm that you want to extract all pages and create a new document for each extracted page.
     If you want to extract the pages, click Yes to confirm. The pages are extracted from the document and appear in the Folder Objects pane, which refreshes to display all the extracted pages as new documents.

Showing and Hiding Annotations

To show or hide annotations in a document, click and select Hide from the pop-up menu.

Using Nolij Web Annotations

Your user role determines if you can annotate and redact documents. For more information about roles, refer to Understanding Nolij Web User Roles and Privileges on page 27.

You can add Nolij Web annotations to documents in Nolij Web workflows, ImageNow workflows, and ImageNow views. However, Nolij Web annotations do not appear if they are viewed in ImageNow.

Your administrator can configure ImageNow as the document storage repository for Nolij Web workflows for your department and can also configure Nolij Web to use either Nolij Web or ImageNow annotations. For information about adding ImageNow annotations, refer to Using ImageNow Annotations on page 110.

Note When you add an annotation, you can continue to add annotations of the same type until you click or .

Note For Nolij Web annotations, annotation size, font size, and background color you use are saved as preferences for that annotation type. The next time you add annotations of a particular annotation type, these preferences are applied.

Refer to the following topics for more information:

- Highlighting Documents on page 107.
Highlighting Documents

To highlight a document, complete the following steps.

1. Complete one of the following actions.
   
   - Click 🗿️ and then click **Highlight** in the **Document Viewer** toolbar.
   
   - Right-click anywhere in the **Document Viewer** and select **Annotation Tools > Highlight** from the pop-up menu.

2. Click the document and drag your mouse across the area you want the highlight to appear.

3. To change the color of the highlight, right-click it and select **Color**. For more information about changing colors, refer to **Modifying Annotation Colors on page 116**.

4. Click 📄 to save your changes.
Redacting Documents

To obscure an area of a document, complete the following steps.

1. Complete one of the following actions.
   - Click and then click **Redaction** in the **Document Viewer** toolbar.
   - Right-click anywhere in the **Document Viewer** and select **Annotation Tools > Redaction** from the pop-up menu.

2. Click the document in the area you want to obscure and drag your mouse across the area you want the redaction to appear.

3. To change the color of the redaction, right-click it and select **Color**. For more information about changing colors, refer to [Modifying Annotation Colors on page 116](#).

4. Click to save your changes.

Stamping Documents

To place a stamp on a document, complete the following steps.

1. Complete one of the following actions.
   - Click and then click **Stamp** in the **Document Viewer** toolbar.
   - Right-click anywhere in the **Document Viewer** and select **Annotation Tools > Stamp** from the pop-up menu.

2. To add custom image stamps or text stamps, which are configured by your administrator, select the appropriate stamp from pop-up menu.

3. Click the document in the area you want to stamp it.

4. For a text stamp, to modify the font color, right-click the stamp and select **Font Color**. For more information about changing colors, refer to [Modifying Annotation Colors on page 116](#).

5. Click to save your changes.

Drawing Circles

To draw a circle on a document, complete the following steps.

1. Complete one of the following actions.
   - Click and then click **Circle** in the **Document Viewer** toolbar.
   - Right-click anywhere in the **Document Viewer** and select **Annotation Tools > Circle** from the pop-up menu.
2. Click the document and drag your mouse across the area you want the circle to appear.

3. To modify the color, right-click the circle and select Color. For more information about changing colors, refer to Modifying Annotation Colors on page 116.

4. Click to save your changes.

Drawing Lines

To draw a line on a document, complete the following steps.

1. Complete one of the following actions.

   - Click and then click Line in the Document Viewer toolbar.
   - Right-click anywhere in the Document Viewer and select Annotation Tools > Line from the pop-up menu.

2. Click the document and drag your mouse across the area you want the line to appear.

3. To modify the color, right-click the line and select Color. For more information about changing colors, refer to Modifying Annotation Colors on page 116.

4. Click to save your changes.

Adding Free Text

To place a text box on a document, complete the following steps.

1. Complete one of the following actions.

   - Click and then click Free Text in the Document Viewer toolbar.
   - Right-click anywhere in the Document Viewer and select Annotation Tools > Free Text from the pop-up menu.

2. Click the document in the area you want the text box to appear.

3. To modify the text that appears in the text box, right-click the text box and select Edit Text; then, type the text and press Enter on your keyboard.

4. To modify the font color, right-click the text box and select Color. For more information about changing colors, refer to Modifying Annotation Colors on page 116.

5. To modify the font size, right-click the text box and select Font Size. Next, in the Font Size dialog box, type the font size and click OK. Values can be 1 through 50.

6. Click to save your changes.

Drawing Squares

To draw a square on a document, complete the following steps.
1. Complete one of the following actions.
   - Click \[\text{ }\] and then click \textbf{Square} in the \textbf{Document Viewer} toolbar.
   - Right-click anywhere in the \textbf{Document Viewer} and select \textbf{Annotation Tools > Square} from the pop-up menu.

2. Click the document and drag your mouse across the area you want the square to appear.

3. To modify the color, right-click the square and select \textbf{Color}. For more information about changing colors, refer to \textit{Modifying Annotation Colors} on page 116.

4. Click \[\text{ }\] to save your changes.

---

**Adding Sticky Notes**

To add a sticky note to a document, complete the following steps.

1. Complete one of the following actions.
   - Click \[\text{ }\] and then click \textbf{Sticky Note} in the \textbf{Document Viewer} toolbar.
   - Right-click anywhere in the \textbf{Document Viewer} and select \textbf{Annotation Tools > Sticky Note} from the pop-up menu.

2. Click the document and drag your mouse across the area you want the sticky note to appear.

3. To modify the text that appears in the sticky note, right-click the sticky note and select \textbf{Edit Text}; then, type the text and press \textbf{Enter} on your keyboard.

4. To modify the font color, right-click the sticky note and select \textbf{Font Color}. For more information about changing colors, refer to \textit{Modifying Annotation Colors} on page 116.

5. To modify the font size, right-click the sticky note and select \textbf{Font Size}. Next, in the Font Size dialog box, type the font size and click \textbf{OK}. Values can be 1 through 50.

6. To modify the color of the sticky note, right-click the sticky note and select \textbf{Color}. For more information about changing colors, refer to \textit{Modifying Annotation Colors} on page 116.

7. Click \[\text{ }\] to save your changes.

---

**Using ImageNow Annotations**

Your administrator can configure Nolij Web to use ImageNow as the document storage repository. In this scenario, Nolij Web can be configured to use either Nolij Web annotations or ImageNow annotations.

If you are using ImageNow annotations, any existing Nolij Web annotations for documents belonging to your department are no longer available. The following types of ImageNow annotations are supported: highlight, oval, text, line, rectangle, and custom annotations of these types. Refer to the ImageNow user guide for detailed information about ImageNow annotations.

If you are using Nolij Web annotations, refer to \textit{Using Nolij Web Annotations} on page 106.
Refer to the following topics for more information.

- Highlighting Documents on page 111.
- Drawing Ovals on page 112.
- Drawing Lines on page 112.
- Adding Text on page 113.
- Drawing Rectangles on page 113.
- Adding URLs on page 114.
- Adding Checks on page 114.
- Adding Sticky Notes on page 115.
- Adding Stamps on page 115.

Highlighting Documents

To highlight a document, complete the following steps.

1. Complete one of the following actions.
   
   - Click  in the Document Viewer toolbar, select Highlight, and select the highlight you want to add.
   - Right-click anywhere in the Document Viewer, select Annotation Tools > Highlight, and select the highlight you want to add from the pop-up menu.

2. Click the document and drag your mouse across the area you want the highlight to appear.

3. To change the color of the highlight, right-click it and select Color. For more information about changing colors, refer to Modifying Annotation Colors on page 116.

4. Click  to save your changes.
Drawing Ovals

To draw an oval on a document, complete the following steps.

1. Complete one of the following actions.

   - Click in the Document Viewer toolbar, select Oval, and select the oval you want to add.
   - Right-click anywhere in the Document Viewer, select Annotation Tools > Oval, and select the oval you want to add from the pop-up menu.

2. Click the document and drag your mouse across the area you want the circle to appear.

3. To change the line weight of the oval, right-click it and select Line Weight. In the Line Weight dialog box, type the width of the line and click OK.

4. To change the line color of the oval, right-click it and select Line Color. For more information about changing colors, refer to Modifying Annotation Colors on page 116.

5. To change the fill color of the oval, right-click it and select Fill Color. For more information about changing colors, refer to Modifying Annotation Colors on page 116.

6. Click to save your changes.

Drawing Lines

To draw a line on a document, complete the following steps.

1. Complete one of the following actions.

   - Click in the Document Viewer toolbar, select Line, and select the line you want to add.
   - Right-click anywhere in the Document Viewer, select Annotation Tools > Line, and select the line you want to add from the pop-up menu.

2. Click the document and drag your mouse across the area you want the line to appear.

3. To change the weight of the line, right-click it and select Line Weight. In the Line Weight dialog box, type the width of the line and click OK.

4. To change the color of the line, right-click it and select Color. For more information about changing colors, refer to Modifying Annotation Colors on page 116.

5. Click to save your changes.
Adding Text

To place a text box on a document, complete the following steps.

1. Complete one of the following actions.
   
   • Click in the Document Viewer toolbar, select Text, and select the text box you want to add.
   
   • Right-click anywhere in the Document Viewer, select Annotation Tools > Text, and select the text box you want to add from the pop-up menu.

2. Click the document where you want the text box to appear.

3. To modify the text, right-click the text box and select Edit Text; next, type the text and press Enter on your keyboard.

4. To modify the font typeface, right-click the text box and select Font > Font Face; then select the typeface from the menu.

5. To modify the font style, right-click the text box and select Font > Font Style; then select the font style from the menu.

6. To modify the size of the font, right-click the text box and select Font > Size. In the Font Size dialog box, type the size of the font and click OK.

7. To modify the font alignment, right-click the text box and select Font > Alignment; then select the alignment and click OK.

8. To modify the font color, right-click the text box and select Font > Color. For more information about changing colors, refer to Modifying Annotation Colors on page 116.

9. Click to save your changes.

Drawing Rectangles

To draw a rectangle on a document, complete the following steps.

1. Complete one of the following actions.
   
   • Click in the Document Viewer toolbar, select Rectangle, and select the rectangle you want to add.
   
   • Right-click anywhere in the Document Viewer, select Annotation Tools > Rectangle, and select the rectangle you want to add from the pop-up menu.

2. Click the document and drag your mouse across the area you want the rectangle to appear.

3. To change the line weight of the rectangle, right-click it and select Line Weight. In the Line Weight dialog box, type the width of the line and click OK.

4. To change the line color of the rectangle, right-click it and select Line Color. For more information about changing colors, refer to Modifying Annotation Colors on page 116.
5. To change the fill color of the rectangle, right-click it and select **Fill Color**. For more information about changing colors, refer to *Modifying Annotation Colors on page 116*.

6. Click to save your changes.

**Adding URLs**

To add a URL to a document, complete the following steps.

1. Complete one of the following actions.
   - Click in the **Document Viewer** toolbar, select **URL**, and select the URL you want to add.
   - Right-click anywhere in the **Document Viewer**, select **Annotation Tools > URL**, and select the URL you want to add from the pop-up menu.

2. Click the document where you want the URL to appear.

3. To modify the URL of the annotation, right-click it and select **Edit Text**. In the **Edit Text** dialog box, type the text and click **OK**.

4. To modify the text of the URL that displays, right-click the URL annotation and select **Edit URL**. In the **Edit URL** dialog box, type the URL text and click **OK**.

5. To modify the font typeface, right-click the URL and select **Font Face**; then select the typeface you want to use.

6. To modify the font size, right-click the URL and select **Size**. In the **Size** dialog box, type the font size and click **OK**.

7. To modify the font color, right-click the URL and select **Color**. For more information about changing colors, refer to *Modifying Annotation Colors on page 116*.

8. Click to save your changes.

**Adding Checks**

To add a check to a document, complete the following steps.

1. Complete one of the following actions.
   - Click in the **Document Viewer** toolbar, select **Check**, and select the check you want to add.
   - Right-click anywhere in the **Document Viewer**, select **Annotation Tools > Check**, and select the check you want to add from the pop-up menu.

2. Click the document in the area you want the check to appear.
3. To change the color of the check, right-click it and select **Color**. For more information about changing colors, refer to **Modifying Annotation Colors** on page 116.

4. Click ✅ to save your changes.

### Adding Sticky Notes

To add a sticky note to a document, complete the following steps.

1. Complete one of the following actions.
   - Click 📝 in the **Document Viewer** toolbar, select **Sticky Note**, and select the sticky note you want to add.
   - Right-click anywhere in the **Document Viewer**, select **Annotation Tools > Sticky Note**, and select the sticky note you want to add from the pop-up menu.

2. Click the document where you want the sticky note to appear.

3. Right-click the sticky note and select **Open**.

4. In the **Sticky Note** dialog box, type the text for the sticky note and click **Add**. After you add text, you cannot change it. The text that you enter appears in the **History** pane, and text appears in descending order by the time it was added. The user name of the individual who added the text and the date on which the text was added also appear with the text.

5. Click **Close** to close the dialog box.

### Adding Stamps

To add a stamp to a document, complete the following steps.

1. Complete one of the following actions.
   - Click 📝 in the **Document Viewer** toolbar, select **Stamp**, and select the stamp you want to add.
   - Right-click anywhere in the **Document Viewer**, select **Annotation Tools > Stamp**, and select the stamp you want to add from the pop-up menu.

2. Click the document where you want the stamp to appear.

3. To modify the text, right-click the stamp and select **Edit Text**; next, type the text and press **Enter** on your keyboard.

4. To modify the font typeface, right-click the stamp and select **Font Face**; then select the typeface from the menu.

5. To modify the font style, right-click the stamp and select **Font Style**; then select the font style from the menu.

6. To modify the size of the font, right-click the stamp and select **Font > Size**. In the **Font Size** dialog box, type the size of the font and click **OK**.

7. To modify the font alignment, right-click the stamp and select **Font > Alignment**; then select the alignment and click **OK**.
8. To modify the font color, right-click the stamp and select **Font > Color**. For more information about changing colors, refer to *Modifying Annotation Colors on page 116.*

9. To modify the type of stamp frame that bounds the text of the stamp, right-click the stamp and select **Frame > Frame Type**; then select the type of frame to use.

10. To modify the roundness of the stamp frame, right-click the stamp and select **Frame > Roundness**. In the **Roundness** dialog box, type the size of the roundness and click **OK**.

11. To modify the margins of the stamp frame, right-click the stamp and select **Frame > Margins**. In the **Margins** dialog box, type the size of the margins and click **OK**.

12. To modify the line weight of the stamp frame, right-click the stamp and select **Frame > Line Weight**. In the **Line Weight** dialog box, type the width of the line and click **OK**.

13. To modify the line color of the stamp frame, right-click the stamp and select **Frame > Line Color**. For more information about changing colors, refer to *Modifying Annotation Colors on page 116.*

14. To modify the fill color (the color that displays in the background and in the boundary of the stamp), right-click the stamp and select **Frame > Fill Color**. For more information about changing colors, refer to *Modifying Annotation Colors on page 116.*

15. Click ☐ to save your changes.

**Modifying Annotation Colors**

You can modify the colors of most ImageNow or Nolij Web annotations and the font colors for annotations that support text, such as text boxes. When you right-click an annotation and select the option to modify the annotation or font color, you can select a color from the color pallet that appears or set a custom color.

You can set a custom color by selecting **Customize Color...** and performing the following steps in the Color Chooser dialog box.

**Note** The color you select for a Nolij Web annotation is saved as a preference for that annotation type.

1. Set the color of the annotation or redaction by performing any of the following actions.
   - Use the color selector or color slider.

     In the color selector area, select ☐ and move it to the desired color, or click the color slider and move it to the desired color.
Set a color by providing the appropriate values in the H, S, and V text fields to configure the hue, saturation, and value.

1. Click the H radio button and type a number in the H text field or use the color slider to set the hue. Hue is expressed as an angle from 0 to 360 degrees corresponding to a location on the color wheel.

2. Set the saturation and value. Click the S or V radio button and set the value using the color selector area or the color slider, or type numbers in the S or V fields. Saturation and value are expressed as percentages.

- Set a color by providing the appropriate values in the R, G, and B fields. Complete one of the following actions to set the color:
  - Click the R, G, or B radio button and type numbers in the R, G, and B text fields. Valid values range from 0 to 255, where 0 is no color, and 255 is pure color.
  - Click the R, G, or B radio button and set the color using the color selector area or the color slider.

- Set a color by providing its hexadecimal value, which is the six-digit number that defines the red, green, and blue components of a color, in the # text field. Each digit ranges in value from 0 to f. For instance, type ffffff for white or ff0000 for pure red.

2. Click OK to save your changes and close the dialog box.

3. Click \( \text{ } \) to save your changes.

Resizing Annotations and Redactions

To resize an annotation or redaction, complete the following steps.

1. In the Document Viewer toolbar, click \( \text{ } \).

2. In the Document Viewer, place your mouse on the edge of an annotation or redaction until the mouse pointer changes to \( \text{ } \) (to resize horizontally), to \( \text{ } \) (to resize vertically), or to or to \( \text{ } \) or \( \text{ } \) (to resize both horizontally and vertically).

3. Click the annotation or redaction and drag and drop it to the desired location to resize it.

4. Click \( \text{ } \) to save your changes.

Moving Annotations and Redactions

To move an annotation or redaction, complete the following steps.

1. In the Document Viewer toolbar, click \( \text{ } \).

2. In the Document Viewer, click the annotation or redaction you want to move.

3. Drag and drop it to the location in which you want it to appear.
4. Click to save your changes.

Deleting Annotations and Redactions

To delete an annotation or redaction, complete the following steps.

1. In the Document Viewer toolbar, click.
2. In the Document Viewer, right-click the annotation or redaction you want to delete.
3. From the pop-up menu, select Delete Annotation.
4. Click to save your changes.

Working with Forms

**Note** You can only view and use forms when you have the appropriate privileges.

Forms display SIS information associated with a folder. Additionally, they can be used for collecting and adding information to the database directly. You can retrieve this information later, modify it, and resave it to the database.

You can detach a form from Nolij Web and move it within the browser. Refer to Detaching and Attaching Forms in the Form Pane on page 119.

To view and use a form, complete the following steps.

1. Perform one of the following actions.
   - For Nolij Web workflows, select the workflow in which to work from the Workflow/View drop-down box. Next, find the folder for which you want to view the form and click it in the Query Results pane.
   - For ImageNow workflows, select the workflow in which to work from the Workflow/View drop-down box. Find the folder for which you want to view the form and click it in the Workflow pane.
   - For ImageNow views, select the View in which you want to work from the Workflow/View drop-down box. Find the folder for which you want to view the form and click it in the View pane.

   The form displays additional information associated with the folder.

2. A drop-down box appears in the Form pane and displays all forms you can use. From the drop-down box, select the form you want to use; the Form pane refreshes and displays the selected form.

3. If the form is configured appropriately, you can add, change, or delete information as needed. When you modify information, a red triangle icon appears in the upper left corner of the field.

   Your Nolij Web administrator may have configured the form field to accept certain criteria; for example, the entry may need to have a certain amount of characters or may not contain empty spaces for the entry to be valid.

   If the entry does not meet the specified criteria, the field is highlighted in red.

   You can still save such information; Nolij Web displays a message indicating that the information is not valid and prompts you if you want to continue saving the information.
4. To save your changes, click ![Save Button]. Changes are saved to the database. Depending on your Nolij Web configuration, a form may refresh when you click a different document or folder. The Folder Objects pane refreshes and displays updated information.

5. To print a form, complete the following substeps.

   1. In the **Form** pane, click ![Print Button].
   2. Set the appropriate print settings and print the document.

   **Note** You can print forms in Nolij Web 6.8.4 and higher.

**Detaching and Attaching Forms in the Form Pane**

To detach a form, which allows you to display the form in a detachable window and which you can move within the browser, complete the following step.

In the **Form** pane, click ![Detach Button]. The form displays in a window detached from Nolij Web.

You can move the form by clicking on it; when the mouse pointer changes to ![Arrow Pointer], press down on your mouse and move the window to the appropriate location.

To resize the form, place your mouse on the edge of the form until the mouse pointer changes to ![Double Arrow], ![Up Arrow], ![Left Arrow], or ![Right Arrow] (to resize horizontally), ![Left Arrow] or ![Right Arrow] (to resize vertically), or ![Double Arrow] or ![Up Arrow] (to resize both horizontally and vertically).

You can reattach the form to Nolij Web by clicking ![Attach Button] in the detached form. The form is reattached to Nolij Web in the **Form** pane.

**Working with Reports**

Depending on your Nolij Web configuration and your permissions, you can view reports and advanced reports. Reports are older formats of reports supported in Nolij Web; advanced reports are in a newer format.
Refer to the following topics for information about viewing and working with reports:

- Report Viewer Toolbar on page 120.
- Viewing Reports on page 120.
- Exporting Reports on page 121.
- Viewing Advanced Reports on page 122.
- Exporting Advanced Reports on page 122.
- Printing Advanced Reports on page 122.

Report Viewer Toolbar

You can open reports by clicking in the main toolbar and selecting View Reports from the pop-up menu. The View Reports window opens in a separate window and displays the reports you can view.

The View Reports toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Split Screen]</td>
<td>Split Screen</td>
<td>Divides the Report Viewer into two panes.</td>
</tr>
<tr>
<td>![Single Screen]</td>
<td>Single Screen</td>
<td>Merges a split screen into a single screen.</td>
</tr>
<tr>
<td>![Export to Text File]</td>
<td>Export to Text File</td>
<td>Exports the report to a text file.</td>
</tr>
<tr>
<td>![Export to Excel File]</td>
<td>Export to Excel File</td>
<td>Exports the report to a Microsoft Excel file.</td>
</tr>
<tr>
<td>![Pie Chart]</td>
<td>Pie Chart</td>
<td>Displays the report as a pie chart.</td>
</tr>
<tr>
<td>![Line Chart]</td>
<td>Line Chart</td>
<td>Displays the report as a line chart.</td>
</tr>
<tr>
<td>![Area Chart]</td>
<td>Area Chart</td>
<td>Displays the report as an area chart.</td>
</tr>
<tr>
<td>![Point Chart]</td>
<td>Point Chart</td>
<td>Displays the report as a point chart.</td>
</tr>
<tr>
<td>![Bar Chart]</td>
<td>Bar Chart</td>
<td>Displays the report as a bar chart.</td>
</tr>
</tbody>
</table>

Viewing Reports

**Note** You can view reports only when you have the appropriate privileges.
**Note** To view reports, complete the following steps.

1. Select **Tools > View Reports**.
2. Click the **Report Type** drop-down button and select the report you want to view.
3. You can select the format in which to view the report by selecting the appropriate option in the toolbar. You can select the following formats:
   - Pie chart: Click the button.
   - Line chart: Click the button.
   - Area chart: Click the button.
   - Point chart: Click the button.
   - Bar chart: Click the button.

   Additionally, you can split the screen into two panes by clicking . Doing so enables you to view two reports—or one report in two different formats—at one time. Click to merge the screens into a single screen.

**Exporting Reports**

You can export a report as a text or Microsoft Excel file by completing the following steps.

1. Select **Tools > View Reports**.
2. In the Report Viewer toolbar, complete one of the following actions.
   - Click to export the report as a text file. The text file appears in a pop-up window in your browser.
   - Click to export the report as a Microsoft Excel file.
3. Set the location where you want to save the file and save it.
Viewing Advanced Reports

1. Select Tools > View Advanced Reports.
2. From the drop-down box, select the report you want to view.

   The report displays as a preview with only the first page of the report displayed. To view the entire report, click ; the report displays in a separate window.

Exporting Advanced Reports

You can export a report as a CSV file (comma-separated values file; for example, Microsoft Excel) by completing the following steps.

1. Select Tools > View Advanced Reports.
2. Click to export the report as a CSV file.
3. Set the location where you want to save the file and save it.

Printing Advanced Reports

To print an advanced report, perform the following steps.

1. Select Tools > View Advanced Reports.
2. From the drop-down box, select the report you want to print and click .

Working with the Communication Window

You can communicate with other Nolij Web users and view informational and debug messages in the Communication pane. Refer to these topics for more information.

- Collaborating with Nolij Web Users on page 122.
- Viewing Console Messages on page 123.
- Viewing Debug Messages on page 123.

Collaborating with Nolij Web Users

Note You can communicate only with other users who have permission to use the collaboration tool.

To collaborate with other users, complete the following steps.

1. Select Tools > Communication Window.
2. To display a list of Nolij Web users and their corresponding roles, click the Collaboration tab.
Initially, you can view only users who are online or who have been online since you logged in. To see all users in a role, both online and offline, double-click the role. The names of users who are offline appear in italics.

3. Double-click the user with whom you want to communicate and enter the necessary information in the dialog box.

You can send messages to offline users. An offline user receives the message the next time he or she logs in. The message you send contains the time and date that you sent it.

Note You cannot see messages sent to you unless you are logged in using the role to which messages were sent.

4. Click Send to send the message to the user.

Viewing Collaboration History

To view all previous messages you have sent to and received from another user, perform the following steps.

1. Open a collaboration session with the user. Refer to Collaborating with Nolij Web Users on page 122.

2. Click in the collaboration dialog box.

3. Click Show All History.

   All messages exchanged between you and the other user are displayed.

Viewing Console Messages

In the Collaboration window, click the Console tab to view informational messages, such as the number of results returned from a query.

To clear messages, click and click Clear.

Viewing Debug Messages

If problems related to the user interface occur, the Debug tab appears in the Communication pane; click it to view debug messages.
Appendix A: Using URL Launch

You can open an ImageNow workflow, document view, folder view, Nolij Web workflow, folder, or document directly in Perceptive Nolij Web through the URL you enter in your browser. Use the following format:

\(<\text{Nolij\_Web\_Server\_URL}>\text{/NolijWeb/public/urllaunch.jsp<!parameters>\>

If you are not already logged in to Nolij Web, you are redirected to the login screen. You must log in to Nolij Web within two minutes for the URL launch to activate. After two minutes, the URL expires and you must navigate to the URL again to open the specified view.

**Note** You can open Nolij Web workflows, folders, or documents in Nolij Web 6.8.4 and higher.

Refer to the following topics for more information.

- Opening ImageNow workflows on page 125.
- Opening ImageNow document and folder views on page 126.
- Opening ImageNow folders on page 127.
- Opening Nolij Web workflows, folders, and documents on page 128.

Opening ImageNow workflows

The following table describes the specific parameters you use to open ImageNow workflows.

**Note** Separate multiple parameters using an ampersand (&).
Table 4: ImageNow Workflow URL Parameters

<table>
<thead>
<tr>
<th>Parameters and Values</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>action=workflow&amp;action_name=&lt;workflow_name&gt;</td>
<td>Opens an ImageNow workflow.</td>
<td>To open the workflow My Workflow, enter: https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=workflow&amp;action_name=My Workflow</td>
</tr>
<tr>
<td>queue=&lt;queue_name&gt;</td>
<td>Opens a queue within a workflow. Use with action=workflow&amp;action_name=&lt;workflow_name&gt;.</td>
<td>To open the Step 1 queue in the My Workflow workflow, enter: https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=workflow&amp;action_name=My Workflow&amp;queue=Step 1.</td>
</tr>
<tr>
<td>field1=&lt;field1&gt; field2=&lt;field2&gt; field3=&lt;field3&gt; field4=&lt;field4&gt; field5=&lt;field5 &gt; doctype=&lt;doctype&gt; drawer=&lt;drawer&gt;</td>
<td>Use these optional filter parameters to display only documents that match specified filter parameters in a queue. Use with queue=&lt;queue_name&gt;. Each parameter can appear only once. If you use multiple parameters, Perceptive Nolij Web considers each parameter an AND parameter.</td>
<td>• To display documents in the Drawer 3 drawer in the My Workflow workflow, enter: https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=workflow&amp;action_name=My Workflow&amp;drawer=Drawer 3. • To display documents with the document type of application in the Drawer 3 drawer in the My Workflow workflow, enter: https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=workflow&amp;action_name=My Workflow&amp;drawer=Drawer 3&amp;doctype=application.</td>
</tr>
<tr>
<td>role=&lt;role_code&gt;</td>
<td>Optional parameter that specifies the role you use to log in to Nolij Web.</td>
<td>To log in to the Nolij Web role 125 and open the My Workflow workflow, enter: https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=workflow&amp;action_name=My Workflow&amp;role=125.</td>
</tr>
</tbody>
</table>

Note: This parameter is supported in Nolij Web 6.8.4 and higher.

Opening ImageNow document and folder views

The following table describes the specific parameters you use to open ImageNow document and folder views.

Note: Separate multiple parameters using an ampersand (&).
Table 5: ImageNow Document and Folder View Parameters

<table>
<thead>
<tr>
<th>Parameters and Values</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>action=workflow&amp;action_name=&lt;view_name&gt;</td>
<td>Use this parameter to open an ImageNow document or folder view.</td>
<td>To open the My Documents document view, enter:</td>
</tr>
<tr>
<td>field1=&lt;field1&gt;</td>
<td>Use these optional filter parameters to display only documents that match specified filter parameters in document or folder views.</td>
<td>• To display documents with the field 5 value 1234 in the My Documents document view, enter:</td>
</tr>
<tr>
<td>field2=&lt;field2&gt;</td>
<td></td>
<td>• To display documents with the document type of application and with a field 5 value of 1234 in the My Documents document view, enter:</td>
</tr>
<tr>
<td>field4=&lt;field4&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>field5=&lt;field5&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>doctype=&lt;doctype&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>drawer=&lt;drawer&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>role=&lt;role_code&gt;</td>
<td>Optional parameter that specifies the role you use to log in to Nolij Web.</td>
<td>To log in to the Nolij Web role 908 and open the My View document view, enter:</td>
</tr>
<tr>
<td></td>
<td>Note This parameter is supported in Nolij Web 6.8.4 and higher.</td>
<td>https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=workflow&amp;action_name=My View&amp;role=908.</td>
</tr>
</tbody>
</table>
Opening Nolij Web workflows, folders, and documents

The following table describes the specific parameters you use to open Nolij Web workflows, folders, and documents.

**Note** Separate multiple parameters using an ampersand (&).

**Note** You can open Nolij Web workflows, folders, or documents in Nolij Web 6.8.3 and higher.

---

Table 6: ImageNow Folder URL Parameters

<table>
<thead>
<tr>
<th>Parameter and Value</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>action=folder&amp;folder=&lt;folder_id&gt;</td>
<td>Opens a folder.</td>
<td>To open the folder 123AB1A_123AB1AB1112AB, enter: https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=folder&amp;folder=123AB1A_123AB1AB1112AB</td>
</tr>
<tr>
<td>role=&lt;role_code&gt;</td>
<td>Optional parameter that specifies the role you use to log in to Nolij Web.</td>
<td>To log in to the Nolij Web role 765 and open the folder 123AB1A_123AB1AB1112AB, enter: https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=folder&amp;folder=123AB1A_123AB1AB1112AB&amp;role=765,</td>
</tr>
</tbody>
</table>

---

*Note* This parameter is supported in Nolij Web 6.8.4 and higher.
<table>
<thead>
<tr>
<th>Parameters and Values</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>folder=&lt;folderid_or_batch_folder_name&gt;</td>
<td>Optional parameter that opens a folder or batch folder within a workflow. For folders, use the folder ID; for batch folders, use the batch folder name. &lt;br&gt;Use with action=workflow&amp;action_name=.&lt;br&gt;&lt;br&gt;• To open the 00123456 folder in the My Nolij Web Workflow workflow, enter: &lt;br&gt;https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=workflow&amp;action_name=My Nolij Web Workflow&amp;folder=00123456. &lt;br&gt;&lt;br&gt;• To open the My Batch Folder folder in the My Nolij Web Workflow workflow, enter: &lt;br&gt;https://Nolij_Web_URL/NolijWeb/public/urllaunch.jsp?action=workflow&amp;action_name=My Nolij Web Workflow&amp;folder=My Batch Folder.</td>
<td></td>
</tr>
</tbody>
</table>
Index

adding
  email import rules ...................... 73

annotations
  deleting ................................. 118
  modifying
    colors ................................ 116
  moving ................................. 117
  resizing ............................... 117

batch folder
  deleting ............................... 39

batch folders
  creating ............................ 38

batch queries
  performing ........................... 38

document properties
  viewing ................................ 51

document viewer
  resizing ............................... 106

documents
  deleting .............................. 59
  recovering ........................... 59
  duplicating .......................... 60
  emailing ................................ 61
  indexing ................................ 51
  merging ................................. 60
  moving into folder objects subfolders 61
  moving into query folder ............ 60
  recovering ............................ 59
  renaming ................................ 58
  resizing .............................. 105
  rotating .............................. 105
  versions ................................ 50

email
  importing ................................ 70

email import rules
  adding .................................. 73
  deleting ................................ 75
  modifying .............................. 74
  running ................................ 75

email import rules
  adding .................................. 73
  deleting ................................ 75
  modifying .............................. 74
  running ................................ 75

extracting pages ...................... 106

features ................................ 10

field
  moving .................................. 25
  resizing ................................ 25

folder history
  viewing .................................. 42

folders
  removing from workflow .............. 77

forms .................................... 118

global documents ...................... 52

graphical workflow
  viewing .................................. 77

ImageNow annotations .................. 110
  checks .................................. 114
  highlights ................................ 111
  lines ..................................... 112
  ovals .................................... 112
  rectangles ................................ 113
  stamps .................................. 115
  sticky notes ............................ 115
  text ...................................... 113
  URLs ..................................... 114

ImageNow document properties
  modifying ................................ 89

ImageNow document views
  adding files to ImageNow workflows .... 94
  filtering documents and folders ........ 92

ImageNow folder views
  adding folders to ImageNow workflows .... 95
  deleting folders ........................ 96
  opening folders ........................ 96

ImageNow task views
  completing tasks ........................ 98
  returning tasks ........................ 98

ImageNow workflows

Perceptive Nolij Web User Guide   Page 130 of 132
perceptive
software

deleting items ........................................ 90
filtering documents and folders ................. 84
opening documents in associated applications 89
opening folders ...................................... 87
removing items ..................................... 90
routing items ....................................... 90
setting item status ................................ 90
ImageNow document views
  deleting ImageNow files .......................... 95
importing
  email .................................................. 70
    configuring email server settings ............ 71
    manually ......................................... 72
  rules, adding .................................. 73
  rules, deleting .................................. 75
  rules, modifying ................................ 74
  rules, running .................................. 75
logging in ........................................... 19
modifying
  email import rules ................................ 74
Nolij Web annotations .............................. 106
  circles ........................................... 108
  free text ........................................ 109
  highlights ...................................... 107
  lines ............................................. 109
  redactions ...................................... 108
  squares ......................................... 110
  stamps ......................................... 108
  sticky notes .................................... 110
Nolij Web document properties
  viewing ........................................... 54
Nolij Web queries
  performing ...................................... 34
Nolij Web workflows
  ImageNow document properties
    modifying ...................................... 53
OCR
  words ............................................. 51
    adding ......................................... 51
    correcting .................................... 51
    dictionary .................................... 51
    rejecting ..................................... 51
OCR properties
  viewing .......................................... 51, 55
overview .......................................... 10
panel
  collapsing ...................................... 25
  expanding ...................................... 25
  resizing ......................................... 25
preferences ........................................... 25
  collapsing inboxes and queues ............... 26
  configuring ..................................... 25
  hiding bookmarks ................................ 25
  resetting ........................................ 26
printing documents ................................ 104
privileges
  understanding .................................... 27
query folder
  locking .......................................... 41
query results
  clearing ......................................... 41
  locking ......................................... 41
report
  exporting ........................................ 99
report viewer toolbar .............................. 121
reports
  viewing .......................................... 122
role
  changing ......................................... 26
roles
  understanding .................................... 27
Running ............................................ 75
  email import rules ................................ 75
scanning ............................................ 46
  blank pages ...................................... 47
  inserting pages ................................... 49
  rescanning pages ................................ 49
  scanning into folders and subfolders .......... 46
  scanning multipage documents .................. 47
  single-page documents .......................... 46
searching
  documents in the Folder Objects pane ........ 63
    keyword ......................................... 39
shared documents ................................... 53
starting Nolij Web ................................ 19
subindex queries
  performing ....................................... 36
toolbar
  report viewer .................................... 121
user interface
  understanding .................................... 20
user summary
  viewing .......................................... 83
versions
  documents ........................................
creating ............................... 50
zooming in ............................. 105

zooming out ........................... 105